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Introduction to ProCal

General Overview

ProCal is a suite of programs designed to provide the tools to calibrate all types of
instrumentation and equipment, with virtually no limitations on the types of measurements
recorded. It provides the facilities to configure the basic system, to create and manage test
procedures and also perform measurements or allow entry of measurements made
independently which are stored within an organised database for producing printed or
electronic certificates (i.e. viewable on screen).

This Suite of programs consists of the following:

ProSet

ProSet provides the facility to configure the system, including the certificate numbering,
setting the reference instruments to be used by the system, laboratory Information, user,
program and database paths for use on a network etc.

ProSet also provides the ability to customise user preferences, profiles can be set up for
the system ,assign users login names and passwords, as well as individual user access
permissions.

Note: If the software is installed to be used on a network, ProSet MUST be used to set the COM ports
and instruments up, BEFORE ProCal is used. If the software is only being used on a single workstation
then ProCal can be used without first setting up ProSet.

ProEdit

ProEdit is the procedure management program and allows the creation of a list of tests to
be performed for a specific instrument. The procedures can also contain specific
instructions on how to test an instrument by using picture, text or video prompts.

A procedure can provide information for remote control of instruments using either GPIB
(General Purpose Instrument Bus) or RS232.

There are complete tools for editing, copying and deleting the procedures; there is also a
powerful, yet easy to use Procedure Builder Wizard for the automated writing of
procedures for a range of different equipment.

ProCal

ProCal is the program which ties together all aspects of the system, allowing the user to
select a procedure and perform measurements with automated control of equipment where
configured. This program is designed to guide the user through the series of tests, and
incorporates the facilities to display help and prompts throughout the test sequence. ProCal
can also be configured to produce printed certificates and calibration / test labels at the end
of a test procedure.

ProCal can also allow integration with ProCal-Track, which incorporates job management
from goods-inwards, to paperwork printing and final despatch.
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ProCert

Provides the facility to print out certificates, which have been recorded and stored using
ProCal.

These certificates are easily searchable for by their certificate number, customer name and
more.

Crystal Reports [Optional]

The Crystal Reports software is used to edit the templates for reports and certificates. This
software is not needed to use the templates provided within the ProCal software.
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Setting up a System

1: Install the programs:

Note that when you install the software, additional files containing procedures, reports,
digital pictures, uncertainty templates and an example database containing a few
instruments are also installed. Even paths and directories etc are set to the local drive
allowing the program to be used directly for either evaluation or training without any further
set up besides selecting a calibrator in Proset.

2: Configure the system with Proset.

3: Connect up calibrator & reference instruments:
Use either the serial RS232 interface or the GPIB (IEEE488) interfaces.

Note: To use either IEEE 488 and/or USB to serial converter, the necessary drivers and hardware must
be installed on the computer first.

4: Run ProCal to calibrate an instrument.
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Installing the programs

The CD provided has both ProCal and ProCal-Track, which have separate installation
programs. Please follow the instructions below to install the programs and example files:

This disk contains the full program versions together with many support files, uncertainty templates
and tables for ISO17025, procedures, report/certificate files in crystal reports, etc. plus an example
instrument database with 5 instruments, which can be used as examples to evaluate the software.

Note: to use GPIB control of instruments a NI GPIB (IEEE488) interface will be needed.
To control a Transmille calibrator, use the RS232 interface or a USB to serial converter.
To evaluate without a system calibrator or DMM select Demo mode for instrument in ProSet.

The software will work fully for 30 days after installation. After this period a USB ‘dongle’ will be
required to run the ProCal program and also ProCal track. Transmille will supply the ‘dongle’ when the

software is purchased.

1: Install ProCal from the CD —

Put the Transmille CD in the drive, and allow to auto run

CALI/BRATION SOFTWARE

SOLUTIONS IN CALIBRATION

TRANSMILLE PROFESSIONAL

PROCAL

> INSTALL |

MULTI DISCIPLINE CALIBRATION SOFTWARE

»~ UPGRADE

PROCAL TRACK

LABORATORY MANAGEMENT SOFTWARE

PROCALTRACK

» INSTALL
»~ UPGRADE

PROSALES

SALES MANAGEMENT SOFTWARE

PROSALES

= INSTALL

PROSITE

PROCAL ON-SITE DATABASE MANAGER

~ INSTALL

VISIT
WWW.TRANSMILLE.COM

2

Choose INSTALL next to the ProCal title.

B

EXIT

Should autorun fail to start then the programs can be manually installed. To do this
navigate to My computer, right click the drive with the ProCal CD and choose Explore, then
locate the Setup.exe file which can be found in the ProCal Directory and double click it to

run the software.

It is recommended that the CD browser be used for installing the software.

Follow the on screen instructions for Installation
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B ProCal Calibration Software Full Installation Setup E|

! Welcome ko the ProCal Calibration Software Full Installation
b 2 installakion program.

Setup cannok install systen files or update shared files if they are inuse,
Before proceeding, we recommend that vou close any applications wou may

be running.

Exit Setup

Click on the Install button to proceed

B ProCal Calibration Software Full Installation Setup

Beqin the installation by dlicking the button below,
¢ fl i| Click this button to install ProCal Calibration Software Full Installation
b__‘/ i| software to the specified destination directary,
Directory:
CHiPraCall Change Directory
Exit Sekup

2: Install ProCal-Track from the CD -

USE THE CD BROWSER AS ABOVE - CHOOSE INSTALL UNDER ProCal-Track
To manually install use set-up.exe found in the ProCal-Track directory.
It is recommended that the CD browser be used for installing the software.

Click OK to install

% ProArchive Instrument Archiver Setup

# Whelcome ko the Profrchive Instrument Archiver installation

[ program,
Setup cannot install syskem files or update shared files if they are in use,
Before proceeding, we recommend that vou close any applications vou may

be running.

Exit Setup
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Click on the ProCal-Track button to proceed

T3 ProCal-Track Management Software Full Installation Setup

Bxeqin the installation by clicking the button belaw,

|
é i Click this butten to install ProCal-Track Management Software Full Installation
*___4,/‘ il software to the specified destination directory,
Direckory:
Ci\ProCal-Track), Change Directory

Exit Setup

Complete the installation of ProCal track and ProCal.

How to run the programs

To start ProCal or ProCal-Track, click the Windows Start button, and then click Programs.
Next select Transmille software menu and choose a program to run.

Dell Accessories
Ciell Support Center »

Games 4
Micrasaft Office Toals 3

Internet
Internet Explorer Paint Shop Pro 6 4
S:I E-mail Roxio Creator DE »
Cutlook Express Startup y

é Internet Explarer
Microsaft Access

H Procal-Track

Prosales Microsoft Excel
Microsoft PowerPoint ProCal
?&5 Paint Shop Pro & Microsoft Ward ProCal Setup Wizard
wd msn Z ProCal User Manual
(ZL’? Smart Label Iﬁ Outlook Express ProCal-Track.
£33 PowerDVD DX ProCal-Track Manual
- Adobe Acrobat 7.0 5
o Remobe Assistance ProCal-Tweak
“y Paint & windows Media Player [ Procert
3, wWindows Messenger ProEdit
@, Windows Movie Maker Progales

AllPrograms B

EE ProSet

- Acrobat Distiller 7.0
- Adobe Acrobat 7.0 Standard
’ -
iy Start TP Office 4

From here select the program required. Note there can be more than one program open at
a time. For example ProCal and ProEdit.

First time users Guide to a Quick Evaluation

The first program to run is ProSet.

ProCal User Manual V4.00
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After installation there will be example data set in the fields.
To evaluate the features of ProSet first set up some reference instruments:

1: Select File > Instrument Traceability - For instrument 1 use the dropdown box to select
the system calibrator, set 2041A and click the ‘Uncertainty’ button to view the
uncertainty table for a 2041A, or leave as demo. Check instrument 2 in the list
and set to DMM.

2: Use File - Certificate information to Set the Laboratory address etc and enter the
relevant name/s to be a signatory for the certificates

Book in an Instrument for Calibration with ProCal Track.

Step 1 Start ProCal Track.

Step 2 Select Utilities - Goods Inwards (Book in instrument).
Type ‘1234’ in the serial number box at the top of the screen then press enter.
(This instrument was installed in the database during installation and is
known to ProCal).
Simply click the green ‘Book in’ button - if set ProCal Track will either print
booking in label or Job sheet.

Calibrate the Instrument

Step 1 Start ProCal

Step 2 Select File & Instrument Priority List - List all active Jobs.

Step 3 Click on the Fluke 187 (serial number 1234) you have just booked in.

Step 4 Click ‘calibrate instrument’.

Step 5 The calibration information screen is now displayed, Drop down the tested by
box
and select your name as entered in ProSet.

Step 6 Click Next.

Step 7 The list of procedures, which match the model number, is displayed. Two
procedures

will be displayed, one for closed loop calibration using the 187 infrared serial
interface, the other for manual calibration.
Select the correct procedure for the current system set-up you have.

Step 8 The next window lists reference instruments and uncertainty information.
Click yes.

Step 9 The next window asks for either As Found Calibration or After Adjustment
Calibration

click As Found Calibration and then click next.
Step 10 Prompt for first test, Click next.
Step 11 Now into reading tests, follow instructions.
Step 12 To finish at any time, Control = Finish calibration.
Step 13 Displays test list for review, Click Next.

Step 14 Certificate comments, enter as required.

Step 15 Job information screens, parts used, engineers report etc, Next>next>next.

Step 16 Set instrument status, if unfinished ‘calibration complete’ will be greyed out.
Use other to manually select ‘M-Cal complete awaiting paper work’.

Step 17 Final screen, the next available certificate number is displayed in the box.

Note this number can be typed over if a different number is required.

ProCal User Manual V4.00 Page 13



Procal Calibration Software: User Manual

Click ‘Finish’ to save. If set in ProSet Options can Print the certificate and
label also at this point.

Despatch an Instrument with ProCal Track

Step 1

Step 2

Utilities - Process Paperwork displays a new menu that requires you to enter the job
or picking number for the instrument. The system will load a new menu with three
options ‘exit the current screen’, ‘cancel the process’ or ‘Process Iltems’. Click Process
Items. A smaller menu will appear that allows you to print the paperwork and calibration
sticker. After all items on an order have been processed a message box will ask if you
wish to ‘proceed to despatch now’, click Yes.

Utilities - Despatch will display a menu, which requires you to enter the job or picking
number for the instrument. The system will load a new menu with the instruments
available to despatch on that order, you will need to select who the items will be
shipped by, but before the despatch note is printed the software will want to ‘see’ the
accessories that were booked in with the job. If the system is running with a Bar code
reader and scanner then a label could have been printed with a unique number to each
accessory that had been booked in, this label would need to be scanned before the
despatch paperwork could be printed.

This important features stops instruments being despatched without the accessories
they were booked in with.

This completes the cycle of calibration and the instrument status is returned to ‘with
Customer’ with the calibration date and certificate number all being updated
automatically.
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Setting up the system using ProSet

ProSet allows the user to configure the ProCal software suite to their specifications.

The ProSet File Menu

B ProSet [User Name-
M User Login  Help

Syskem Settings Chrl+5

Yiew Instrument Traceabilicy
Edit Instrument Traceability

View Uncertainty Templates
Edit Uncertainty Templates

Certificate Information Chrl+1
Program Options Chrl+0
User Access Permissions Chel+L

heck Traceable Instruments F1
Configure Label Printer
Print Setup Information

Exit:

Quick overview of the menu options:

In System Settings

1: To begin with set the starting number to use for certificates. Note there are 5
certificate/report types; each with its own counter which will be incremented each time a
certificate of that type is saved. If required, characters can be added before the certificate
number, e.g. ABC1234. This allows for a different numbering system to be used for
example for accredited certificate’s verses standard certificates.

2: For Network systems it is necessary to set the paths for results, procedures etc.
3: If an IEEE488 card is installed click the type installed.
4: Select the relevant Language

In Instrument Traceability

Enter the information about the calibrator & references to be used. This information will be
passed on to the certificate automatically when that reference is used in a calibration. The
instruments on the traceability list will need to be calibrated periodically to ensure the
integrity of the results produced by ProCal.
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Note: The traceable instruments are those that are kept in the laboratory and are used to calibrate all
instruments that require calibration. These instruments will also need to be calibrated on an annual
basis to ensure they output or receive the correct data.

Note the first 10 locations are for the system reference instruments, which ProCal will use
as default. Use the ‘add’ button in the menu bar to add more reference instruments as
required.

On a networked system, reference standards can be placed on the server, which will make
it available to all workstations.

Note: That for evaluation purposes a demo mode can be selected for the three main instruments e.g.
calibrator, scope calibrator and DMM. This mode allows a procedure to be run without a calibrator
connected.

Certificate Information

This section should contain the name and address of the laboratory, contact details and
names of signatories for the laboratory etc.

Program Options

Allows the user to set the defaults modes & operations of ProCal. For example if a
certificate is to be printed at the end of a calibration. Also for options like the menu function
in ProCal to recall a certificate. The Program settings can via File->Program Options to
tailor ProCal to the users specifications.

= Program Options |
— ProCal Default Startup Screen — Show Last Cal. Inzst. Infarmation——
f+ Mo Detault Screen On Starbups [ Shaw Last Cal. Inst. Infarmation
= Show 'Calibrate &n Instrument By Labarataory (D The Instiument Information from the
7~ Show 'Calibrate An Instrurment By Serial Murmber' last calibration will be reloaded on the
i~ Show 'Calibrate An Instrument By Previous Certificate Mumber' e e
" Show 'Calibrate An Instiument By Job Mumber' - Show W aming Messages
= Show 'Instrurnent Calibration Priority List' ¥ Show 'waming Messages
" Show 'Search for a Procedure [Calibrate Instrument]’ W aming messages include
Huote : The soreen selected abowe will be shown on startup of ProCal and will be retumed to at uncertainty £ traceability problems.
the end of each calibration run. —futa Select Calibration Option
— Print Defaults [End of Calibration Run); — Test Fail Message Options—————————— | & Mo Auta Selected Optian
% Mo Test Fail Message ' 1
v Show Certificate Printing Dialog £ Tast Fail Me | Disabled " Select ‘s Found
i [l s e [l = Select 'After Adjustment’
: ; ) » " Test Fail Mez=zage (lgnore Enablad)
[~ Print Calibration Certificatels) The test fail message box has 3 buttons - The 'I:alil_:ration Option' screen will be
[ Print Certificate of Confarmance(s) | | APort. Fetry & lgnore. S vl Ui amye U8 o izt

[ Print Label(s] — Certifizate I_:E_ecall - -
Allow a certificate to be recalled for viewing / editing.

Diefault Hurmber of Copies : I'l 'I [+ Enable Certificate Recall Function

— Statuz Code Maonitoring————— — Repaort Settings
Check status is 0K before Enahle Default Cryztal Report Mame :
r beginning calibration ' Crystal UkAS Certificate. rpt j
Fleportz® i
LCancel ok |
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ProCal Default Start-up Screen

This allows the user to be presented with a default screen to minimise the menu selections
required. For example if the job number were always used to begin a calibration, this
screen would be selected as the default start-up screen. This helps to guide the operator
through the program by automatically presenting the correct screen, which prompts the
user to enter the required information — the job number in this example.

User Access Permissions

Administrators can modify the list of users by selecting the menu item Utilities->Advanced-
>User Access Permissions. A list of users and their user levels is shown:

~% User Access Permissions [El

User Hame User Level Pazsword

: ENGINEER =
Mike : CFERATCR P MmlZ3
Ernie : RDMINISTRATOR H

User Hame |Bert Add a User
User Level |ENGINEEH j — | Delete a User
Paszsword [Dptional] |

Cloze

Add a User

Click “Add a User”. The new user is now selected, Enter the user name, choose the user
level from the drop-down list and choose a password if required.

Edit a User’s Permissions

Select a user in the list and select the new user level from the User Level drop-down list.

Delete a User Button

Select a user in the list and click “Delete a User”.

Close Button

Click “Close” when user update is finished. If the list is empty ProCal-Track will operate
with an unnamed user with the level of Administrator and no password.

System Settings in detail

The system setting screen from File>System settings
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E) System Settings

Data Paths
Certifizates : hASERVERSPLEBLICAPROCALMCERTIFICATES J
Procedures ; YWSERWVERNPUBLICVPROCALNPROCEDIIRES J
Digital Phata's C:APraCal\nstrurnent Photos .l
Stock Data [
Mizcellaneous Information Auta Mumbering Infarmatian
Sustem Mumh 1 Lazt Jzed Certificate Mumbers :
yatern Mumber

Standard Certificate Murnber Cr13533
Marginal Pass Limit JkKAS Certificate Humber 16530

[ of C Certificate Humber CCooom
GPIE Card |nformation
" Brain Boxes® Electrical Safety Test Mumber  ES120002
() Mational InstumertzE Test Report Cetificate Mumber  TRO935
® None Lazt Uzed System |0 10083377

Language Setting

. Ta change the language, select from the
Language |Er‘|§||l$|"| ﬂ list then restart the program.

Cancel ‘

Drive & Directory Information

D ata Paths

Certificates : C:AProCal\Certificates [
Frocedures ; C:FProCalsProcedures [
Digital Phata's : “WSnapServertiSharelnetPhotos 1
Stock Data: C:APraCalhCertificates] [

This section can be used to set the location of data, although on installation of the ProCal
software the directories and paths will automatically be set to the local drive which is
usually the C: drive.

Drive & Directory Information continued

To enable use of the software with networked computers, the certificates and procedures
paths should be used to link a workstation with a main storage server.

To enable ProCal to share the Certificates database it is necessary to set the Certificates,
procedures and also the digital photo paths.

When initially installed on a single computer, these paths are set to point to the local
ProCal installation as default i.e. C:\ProCal\xxx

Using ProCal on a Windows network means that one of the computer will need to be used
as the default location to store data (known as the server). This means that all the data is
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stored on this computer and shared by every other computer (known as a workstation) on
the network.

To allow each workstation to use the server for data storage, the paths to the server need
to be set.

Note: The location of the stored data (the server) should be backed up to a separate location on a daily
basis to combat against any data loss that could occur if any problems arise.

Sharing the ‘C’ drive on the Server

To set the path across the network, the server computer must have its ‘C’ drive shared for
access across the network.

Windows can achieve sharing the ‘C’ Drive:

1. On your desktop, double click on My Computer.

7

[y Computer

b ¢ My Computer |:”§|E|
File  Edit View Favorites Tools  Help ':;'
\_)' J lﬁ /I__\J Search 0 Folders -

address | & My Computer v| &
-~

|2

System Tasks w Local Disk {C:)
Wigw syskem -

infarmation

Ly Add or remave Devices with Removable Storage
programs

[}- Change a setting
.. CVDICD-RAW Drive (D)

=
Other Places

Network Drives

& My Network Places
5 My Documents
) Shared Documents
@ control Panel

e

29 Public on 'Storage System
(Server) (5:)

Scanners and Cameras
Details

My Computer 0 = Logitech QuickCam Pro 4000 _
Swskem Folder w “

2. Right click on your ‘C’ Drive and choose SHARING (note: this will only be available if
your computer is set up on a network).
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4 My Computer

File Edit Wiew Favorites Tools  Help n
) ) ®) o

< \_) Lﬁ 7 Search i Folders

Address | i My Computer V| o

System Tasks

. Open
View system . )
informnation Browse with Paink Shop Pro
L) Addoarremave Devices with Removal ~ Explore
pragrams 7 Search...
[ change a setting s
B DVD,I'CD-RW o Sharing and Securiky. ..
Format...
Other Places
Copy

MNetwork Drives

W My Hebwork Places
[}ty Documents

==l can " Rename
I Shared Documents W Public on 'Stor,
(Server) (5:)
[——=—]

Create Shortcut

Properties

G: Contral Panel

3) Select Security and Sharing, set Shared Name as ‘C:’ Do not enter a password. Click
OK to set.

Local Disk [C:] Properties @

General | Tools || Hardware | Sharing | Quata

Local sharing and security

r- To share this folder

_,J_g anly, drag it to the £
Tao make thiz folder and itz subfolders private zo that
ahly you have access, select the following check box,

thiz computer
falder.

Metwark, sharing and security

, To share thiz folder with both network users and other
uzers of this computer, select the first check box below
and type a thare name.

Share thiz folder on the netwark.

Share name: |E

Allow network. uzers to change my files
Learn more about sharing and security.

_i) ‘windows Firewall iz configured to allow this folder to be shared
with ather computers on the netwark.

g your WWindows Firewal settings

[ ] H Carcel ]

Now the server ‘C’ drive is shared, this can be accessed across the network by the
workstations.

Setting up a Workstation

All that is now required is to set up each workstation to ‘point’ at the server. To do this, the
name of the computer must be known - contact your IT administrator if you do not know
this computer name.

This path will include the name of the computer on the network you will be using as the
server. In this example the name of the computer being used as the server is LabServer.

Note: this name does not need to indicate it is a server; it is simply the name of the computer you are
going to use for the main data storage.
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For the certificates database, the path would be:
\WLABSERVER\C\PROCAL\CERTIFICATES

For the procedures, the path would be:
\\LABSERVER\C\PROCAL\PROCEDURES

For the digital photo’s database, the path would be:
\\LABSERVER\C\PROCAL\CERTIFICATE

System Number

This is optional and will be recorded whenever this computer is used to perform a
calibration.

Marginal Pass Limit

The marginal pass limit is 90% as default. This means that whenever a reading is made
which is 90% or more of its specification (accuracy) then a certificate will display a marginal
pass (where configured to show a Pass / Fail column). This value can be changed to any
percentage required.

GPIB Card Information

GFIB Card Information

(") Brain Boges®

("1 Mational |nstrumentz®
(@ Mone

This section allows a GPIB card to be configured for use by the ProCal software. This
option should be set to ‘None’ unless your computer has a compatible GPIB card installed
in the computer.

Note: To use either the Brain Boxes® or National Instruments® GPIB cards, the relevant drivers MUST be
installed on the computer. The latest National Instruments® drivers are available to download from
www.ni.com

Auto Certificate Numbering Information
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Auta Murnbering nfarmation
Last Uzed Certificate Mumbers :

Standard Certificate Murmber — CM13306
LIKAS Cetificate Murnber 16733

C of C Certificate Mumber CCanom
Electical Safety Test Mumber  ES120002
Test Report Certificate Mumber  TRO42

Last Used System 1D ; Tamo1 47

The auto numbering system allows the user to set a start point from which the computer
will automatically ‘count on’ from, e.g.

If the sequence XYZ0010 were to be entered as the starting number, then the computer
would use this sequence and count up accordingly to XYZ0011, XYZ0012, and XYZ0013
etc.

The different counters are available because a procedure can be set as a specific type of
test, i.e. Standard Certificate, Accredited Certificate, etc. and each of these may want to
have a different prefix.

Note: The reason for these different types is to provide an easy way for users to select procedures.
ProCal allows a user to search for a specific type of procedure, and then to find a specific model
number. This way the user is not presented with a large number of procedures to choose from.

Standard certificate: Categorises a traceable or commercial certificate.

Accredited Certificate: For accredited laboratories.
C of C Certificate: A Certificate of Conformance, or CertCon.

Electrical Safety Test: For procedures which are concerned only with testing electrical
safety (e.g. Portable Appliance Test results).

Test Report Certificate: A test report, typically for new instrument testing on product lines or
in ATE (automatic test equipment) systems where sub assembly testing is performed.

In addition to the certificate numbering system, the System ID counter can also be
customised. This unique reference is given to every instrument and is used by the
computer to link together all related information.

Note: It is recommended that this System ID counter is left as per the default and is not changed unless
you are an experienced user.
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Language Setting

Language Setting . -
" o change the language, select from the
Language |Er‘|§|lISh ﬂ =t then restart the program.

The ProCal suite of programs support multiple languages — if these are available on your
system they will be listed in the drop down box. Simply select the language from this list.
For the new language settings to be implemented, the program must be restarted.

Note: To apply the language change, any ProCal Suite program must be closed and restarted after
selection.
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Traceability Information of Reference standards used.

In order for ProCal to control instruments and / or record information about instruments
used for a calibration these instruments need to be added to the systems traceability list.
The traceable instruments and reference standards are those instruments that are
consistently used to calibrate all of the instruments that pass through the system.

This list can be found in ProSet by clicking File->View Instrument Traceability. The is
comprised of a list of traceable instruments, with the first 10 instruments reserved for

specific types of instrument:

B): Instrument Traceability [VIEW ONLY]

*% NONE *%

1
2
3 ** NONE #*+
4 ** NONE *+

5
6  ** NONE *+
7 ** NONE **

Senal Mumber
Certificate Murmber
Calibration D ate

Calibration nterval

Ma. | Model Humber & Description

|nformation For ** HOME = [LOCAL]

Instrument Model Humber & Description

IIncertainty Template [Optional]

B905 EAntomatic Precision Bridge

Serial Murnber

Wieeks

COR Port [COMI to CORE]) or GRIB Addrezs [0 to 30
M eazured Y alue [lncluding Unitz] [Optional]

on R
[Tl
s

‘m id

R S

&

Edit Uncertainties

Instrument Type ProEdit Test Type
1 Multi-Product Calibrator Meter
2 Multimeter Measurement
3 Oscilloscope Calibrator Oscilloscope
4 Electrical Test Equipment Calibrator Insulation Tester
PAT
RCD Tester
LOOP Tester
5 Reserved for Future Use N/A
6 Reserved for Future Use N/A
7 Reserved for Future Use N/A
8 Reserved for Future Use N/A
9 Reserved for Future Use N/A
10 Reserved for Future Use N/A
11+ User defined instrument — no restriction N/A

ProCal User Manual V4.00

Page 24



Procal Calibration Software: User Manual

As the list indicates, the system instruments are used by ProCal to determine which
instrument to use for a specific type of test.

Each instrument requires full traceability information to be entered, including interface
address and measured value if relevant:

|nformation For EADDS Electrometer [SERYER]

Instrument kodel Mumber & Dezcription |E.-“-‘-.EIEIB Electrometer j ' Local
Serial Number TL907 (&) Server
Certificate Number 14834

Calibration D ate 20410403

Calibration Interval m Waeks

COM Port [COMI to COMS) or GPIE Address [0t 30) [COM2 =
keazured Yalue [Including Unitz] [Optional]

O T

Lt B

neertainty Termplate [Optional] | j Edit Uncertainties

Instrument Model Number and Description

This is selectable from a drop down list for the first 10 system instruments. This list is linked
to the available software drivers enabling communication to / from the specific instrument
selected.

Serial Number

The Serial Number of an instrument should be entered here. If an instrument doesn’t have
a serial number then one can be entered manually.

Certificate Number

Enter the latest calibration certificate number for this instrument here.

Calibration Date
Enter the latest date of calibration here, in the format DD/MM/YYYY.

Calibration Interval

Enter the calibration interval in weeks here — this enables the system to calculate the
recalibration date based on the calibration date and the calibration interval and warn the
user that this instrument is out of its calibration period (or nearing that period — the length of
warning before the next calibration is due can be set by the user e.g. 3 weeks).

COM Port (COM1 to COM8 or GPIB Address 0 to 30)

Enter the relevant address for the instrument here.
This field can be left blank if it is not required.

Measured Value (Including Unit) [Optional]

This field is not valid for the first 10 instruments as the reference instruments use these
places. It allows the measured value for a standard to be stored centrally to allow for easily
updateable values, which may change from calibration to calibration.
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Note: The measured value will be used by ProCal as the nominal test value for tests where this standard
is selected as the reference in the procedure.

Uncertainty Template

Each traceable instrument can have a specific uncertainty template associated with it as
default. This allows the system to be set up so that when a specific traceable instrument is
used within a calibration and the uncertainty is calculated at test time, the uncertainty
template selected here will automatically be incorporated into this calculation. For more
information on uncertainty templates, see the section further on.

Local / Server Storage

The local / server option allows an instrument’s information to be stored on the designated
server computer. This allows several workstations to share the same instrument
information, and avoids the need to enter duplicate information on several workstations.

() Local
(8 Server
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Setting up instrument Uncertainties

Each traceable instrument can have a table of uncertainties assigned to it, which can be

accessed by clicking the Edit Uncertainties button

T

i

Edit Uncertainties

Uncertainties For Model xooc 3458BA Multimeter

Mo, | Range (must end with valid units, eg %, A&, "CY | Imported Uncetainty | Stability of Reference
#% Reading | Fero | % Beading | Fero "
P 1 DCY : O to 100mY 0.0002 0.44uy 0.0005 Tu¥ |7
2 DCY : 100mY¥ to 1Y 0.0002 0.44uy 0.0004 Tuy¥ ||
3 DCY : 1¥ to 10¥ 0.0003 0.0004 2uy
4 DCY : 10% to 100V 0.0003 0.0006 30uv
5 DCY : 100% to 1000V 0.0003 0.0006 100uY
6 DCI : 0 to 100nA 0.00235 20nA 0.003 .04nA
7 DCI : 100nA to TuA 0.00235 20nA 0.002 .04nA
g DCI - TuA to 10uA 0.00235 20nA 0.002 ~4nA
9 DCI - 10uwA to 100uwA 0.00235 20nA 0.002 0.8nA
10 [(DCI: 100uA to TmA 0.000384 0.002 SnA
11 (DCI: TmA to 10mA 0.000437 0.002 H0nA
12 (DCI: 10mA to 100mA 0.000497 0.0035 500nA
13 (DCI: 100mA to 1A 0.000909 0.011 10uA
14 |ACY : 0 to 10m¥ [1Hz to 40Hz) 0.04 25uv 0.03 Juv
15 [ACY : 0 to 10mY [40Hz to 1kHz] 0.015 17uv 0.02 1.1u¥
16 [(ACY : 0 to 10m¥ [1kHz to 20kHz] 0.015 17uv 0.03 1.1u¥
17 |ACY : 0 to 10m¥ [20kHz to 50kHz] 0.05 J0uv 0.1 1.1u¥
18 ACY - 1 o 10mV (50kHZ o 10NkH=1 nna ANy ns 11wy [T
Delete Range Add Range it

Each range can be assigned the following information:

Calibration of Reference : % of Reading

: Zero
Enter the imported uncertainties from the calibration certificate for this instrument:

Stability of Reference : % of Reading

: Zero
Enter the accuracy of this instrument from the manufacturers specifications.

ProCal comes installed with all Transmille calibrator uncertainty tables complete,
incorporating the imported uncertainties for calibrations as performed by Transmille.

Note: If your Transmille calibrator is not calibrated by Transmille, these imported uncertainties will need

to be updated to reflect the uncertainties from the laboratory that calibrated the instrument.
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Adding / Editing Range information

The Uncertainties table can be edited by adding a new range or editing an existing range.

Note: The uncertainty table for system instruments 1 to 10 should not be changed as these are used by
ProCal to automatically determine the correct line to use with a specific test value / frequency.

Simply click on the Add Range button to add a new range, an empty box will appear below
the last range — then enter new details. To edit a range simply select that row and the new
details. To delete a range again highlight the relevant ranges and click the ‘Delete Button’

15 [ACY : 0 to 10mY [40Hz to 1kHz] 0.015 17uv 0.02 1.1u¥

16 [ACY : 0 to 10m¥ [1kHz to 20kHz) 0.015 17u¥ 0.03 1.1u¥

17 |(ACY : 0 to 10m¥Y [20kHz to h0kHz) 0.05 J0uy 0.1 1.1u¥

18 ACY -l tn 10mV (50kHZ to 10NkKH=Z1 nna ANV nhs 11wy [T
Delete Range Add Range E:-:lt

How does ProCal select the correct range / function from the uncertainties table?
ProCal uses a built in look up table to determine the correct range / function / frequency
range for a specific test. This is preset for the following instruments:

All Transmille 2000 Series calibrators
Transmille 2100 Electrical Test Equipment Calibrator
HP / Agilent 3458A

For all other instruments, the specific line required for use, to calculate the uncertainties
must be manually selected. This is covered in further detail in the section on ProEdit.

ProCal User Manual V4.00 Page 28




Procal Calibration Software: User Manual

Uncertainty Templates

For the comprehensive calculation of uncertainties, ProCal allows additional sources of
uncertainty to be incorporated into uncertainty templates which can store such sources as
connection / lead errors, noise etc.

Each uncertainty template can be uniquely named and record one or more source of
uncertainty. As required by M3003, this includes the probability devisor to enable correct
statistical calculation of the final uncertainty.

Uncertainty Templates[VIEW ONLY]

Uncertainty Templates Probabili
Source of Uncertainty Limit Value Distributi?n

100mH Inducatnce Standard a3

100nF Capacitance Standard

100uH Inductance Standard

10mH Inductance Standard

10nF Capacitance Standard

1A to 204 DCI Measure Moise { Flicker *Calculated At Run Time<|  Rlectangular

1H Inductance Standard |

1mH Inductance Standard |

1nF Capacitance Standard

1uF Capacitance Standard |

3200 DCY IMNS 1000V |

3200 DCW IMS 100V |

3200 DCV IMNS 250V |

3200 DCW IMS 500

3200 DSV IMS 50 |

ACI Measure |
|
|
|
|
|
|
|

Divisor | C;

]

alculasted At Run Times Mormal 2.0 1.00

=Calculated At Run Times Rectangular

Resolution Rectangular

[¥%) [P B
—_
=
[}

Rectangular |

ACI Source

ACY Measure

ACY Output

ACY Source

BMC - 1 - Clamp Cail Calibrati
BMC - ACI -1 - 2504 to 100u,
BMC - ACI- 2 - 101u& to Tmé
BMC - ACI-3-1.01mA to 10
BMC - ACI-4 - 10 1mA to 10 »

Wigw Uncertainty Evaluation Wiew Procedure b anual ,_?r} Exit

The left hand list displays the available uncertainty templates, which can be edited.

To create a new template, the user should click on the ‘Add Template’ button.

To edit the method sheet, use a word document with the file name as template. Click on
‘View method sheet’

To edit an existing uncertainty template first select the required template by clicking on the
list. Then click on the box in the table to edit the contents, new uncertainty contributions
can be added in the same way to an existing uncertainty template. Once all the new data
has been entered, just close the Uncertainty Templates window or move onto the next
template and it will save the data.

Note the top 4 lines are always present and are greyed out. The value of these will be
dynamically calculated at run time. Data is taken from the ‘uncertainty’ table in ProSet,
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which contains both the ‘imported uncertainty’ and ‘stability’ for the reference used by
ProCal in that test. Note that ProCal will determine the reference used either automatically
or by the reference selected manually in the procedure by ProEdit. If an uncertainty table
does not exist for the reference selected then a warning message is displayed.

Resolution is taken from the ‘number of digits’ field in the procedure.

Noise/Flicker is entered in the drop down box on the measurement screen. This is treated
as a rectangular contribution with degrees of freedom = infinity in the uncertainty
calculation.

Note: All uncertainty contributions are assumed to have degrees of freedom = infinity.
Should a calculation contain dominant terms or terms with low degrees of freedom then
they should be calculated outside of the auto calculator inside ProCal and be entered either
in the procedure as a Pre calculated term or calculated at run time term and be entered in
the box at the bottom of the measurement screen.

Laboratory Information

The address, signatories and environmental information for the laboratory are set up using
this screen. These settings are stored with each calibration performed, so changing this
information will only affect calibrations performed AFTER the changes. If a certificate or
report is printed before any changes are made then the document will need to be reprinted.

B). Certificate Settings

L abiaratary Infarmatian

Labaratary Hurmber 1234
Certificate Title Laboratory Hame [Certificate Titlg]
Labaratory Address Laboratory Mame
Address Line 1
Addrezs Line 2
Address Line 3
Addrezs Line 4
Signatories
1] &.B. Smith 2] C.0. Jones ]
4 B

ncertainties

Temperature 1 T Mainz Valtage 12 W
Fielative Huridity + 2l % Mains Frequency +1 Hz
Cancel (1]

Note: It is useful to put the laboratory telephone and fax numbers and Email address in the address line
4 location, address length permitting (e.g. TEL: xxxxx xxxxxx ¢ FAX: xxxxx xxxxxx * Email x@x.COM).
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Configuring the Label Printer

Ei Configure Label Printer

" Standard Serial Printer [ASCI Output)

" D0 300,400 Series Printer
(+ Seikao Smart Label Printer® [Label Code : SLP-TMRL]

Part

v COM1
" COM2
" COM3
" COmM4
~ USB

Frinter Maodel
¢ SLP 100
SLP 200
SLP 120
SLP 220

~
~
~
" SLP Pro

LCancel £

" Zebra90

Label Configuration

Print Teszt
Label

Serial No.
Cert No.

Calibrated :
Cal. Due

BEEEEE e
HEEEE S

MR

bR

Systzm D0 :0oc0oo00o

Company Logo Path [Standard Certificates)

Label Footer

@ Include Barcode on Label [Codel 28]

- U=ze the 'Print Test Label butten to

test the label printer settings

To set-up the system label printer select File ->

Configure Label Printer or click the 4 toolbar
button.

Note: For the DYMO printer, all settings are
configured by the DYMO printer installation.
Simply select DYMO 300 Series to use this
printer.
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The Calibration Program ProCal

ProCal Overview

ProCal is the piece of software which is used to perform calibrations on instruments, it
controls this sequence from the starting a calibration to the results of the calibration
combining the before and after adjustment results to the results database in ‘Access’.
These results can then be viewed, or printed into multiple templates as required to meet
the customer’s requirements.

There are many settings in ProSet — ‘program options’ are used to control the default
operation of ProCal to suit individual requirements, including the printing of certificates &
labels after calibration.

ProCal controls the measurement process by loading a ‘calibration procedure’ that can be
created in ProEdit. This procedure is made up of individual measurement tests; the data
held in each test is used by ProCal to control the reference instruments, take the
measurements, calculate uncertainties etc.

There are four main points for performing a calibration with ProCal.

Starting the calibration, entering data on the instrument to be calibrated, selecting the
procedure etc.

Running the procedure, taking the measurements and recording the results.

Conducting necessary adjustments if needed, retaking the measurements and recording
the new results

Finishing the calibration, saving the results, entering comments etc.

ProCal is very flexible in the way it can be operated to meet the requirements of different
users, the options to the user on starting/finishing a calibration are different for the stand
alone calibration system to the networked calibration station integrated with job control
(ProCal Track) software.

In all cases running the measurement procedure is always the same.
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Starting ProCal:

ProCal can be started either from the Start Menu->Transmille Software->ProCal or from
the desktop shortcut, ProCal will ask for a user login (if users have been assigned in

ProSet)
Uzer Mame J & Bailey

IJser Level }-’-‘«DMINISTHATDH

Pazzward | [v tazk

ProCal will then check the reference standards data (as set in ProSet) for any standards
requiring calibration and will display a list of any instruments found. This menu can be set
to appear on the start-up of ProCal to inform the user of any outstanding calibrations. This
list is for information only, and may be closed.

The Following Traceability Problems Have Been Detected

Incomplete traceable instrument entriez exist :

Mo, | Location Drezcription Serial Murmber Recal Due Action

The following traceable instruments require [or are nearing] recalibration - 2 weeks notice given :

Mo, | Location Dezcription Serial Number Recal Due Action

05 : Loczl : B205 Antomztic Precision Bridg : 825 c 14/04/7200% - Reczl A
108 @ Serwver @ Tinsley 100E Resistance Stands : TL100E : 0%/06/200% : Recszl
114 : Serwver : 502 Standard Resistor o TL174 - 0%/0&6/200% : Rec=l
12 : Serwver : Standard Resistor 100mR : TH1g0 : 18/0%/200% @ Recszl
135 : Serwver : CGranite Surfzce Tzkle : THZOO4 - 0&8/0%/200% : Rec=z=l
148 : Server : Fressure Tranasducer S50nBzr : TL315 (020 : 08/0&/200%2 : Reczl
147 : Server : Pressure Transducer 35Bar : TLI1T : D8/0&/200% : Recazl
150 : Server : AC Reszsistance Box - 0.1R to 10 : TL&17  14/0%/200% - Reczl
151 : Server : AC Resistance Box 100kR to 10K : TL237 : 14/03/200% : Recszl

15% : Berwer @ SBtandard Capscitor (3T) 10nF : THZZ24 - 22/

FPrrint Lizt

If a procedure, which uses an instrument in this list, is selected to be used in ProCal, an
error message will be displayed and the calibration will not be able to continue until the
instrument has been calibrated.

2/200% : Reczal W

ProCal will then display a message box as it initialises instruments connected to the PC’s
interfaces. The user will be prompted to either try again or cancel any instrument not
responding.
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ProCal Menus: The File Menu

= ProCal -
File Abiout

Calibrate An Instrument By Syskem ID

By Serial Mumber

By Certificate Number
Search For a Procedure (Calibrate Instrument)  # By Job Nurnber

Instrument Calibration Priority Lisks »

Repair &n Instrument L4

Add after Adjustment Results »

Resume a Calibration (Calibration Incomplete)
Recover a Calibration

Check Instrument Traceability

Exit

A new calibration may be started by selecting from the file menu either:

Calibrate an instrument: - use to start a new calibration.

ProCal will search the database for the instrument from either the ID number, serial no, last
certificate number or job number (if booked in by ProCal Track). This allows instrument
information to be recalled from the database. When a new instrument, unknown to the
database is entered ProCal will display a message box and ask if you wish to create this as
a new instrument, ProCal will then add the instrument details to the data base as you enter
them, saving them in the database so they only need to be entered once. In the future
ProCal will recognise this instrument.

This powerful feature allows ProCal to learn the instruments as they come through the
system, avoiding having to create instruments in the database first.

Instrument Calibration Priority List: - select from a list of instruments in order of priority.

Displays a list of instruments to be calibrated ordered by the number of days left to
calibrate (only available if the instruments have been booked in with ProCal track). This
helps organize the workload and keeps the procession of instruments being
calibrated/repaired in order.

Search for a Procedure: - Select procedure before entering instrument details

Allows the calibration procedure to be selected first before entering instrument details. This
may be useful for an ad-hock calibration or for checking to see if a calibration procedure
exists.
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An unfinished calibration can be completed by selecting:

Add after adjustment results

Entering the certificate number for the before readings starts after adjustment calibration.

Recall a certificate

Enter the certificate number to recall either the before or after adjustment results. Using
this allows mistakes on certificates to be corrected, e.g. comments, instruments details,
even measurements can be remade. This is a very powerful function of ProCal and can
save a great deal of time, avoiding having to completely re-run a calibration. To avoid
misuse of this function it must first be enabled in ProSet — ProCal ‘options’.

Resume a calibration

Displays a list of calibrations marked incomplete as set at the end of calibration. This
allows an incomplete calibration to be saved, then continued later. Click on the instrument
in the list to resume calibration.

Recover a calibration

Should for any reason a calibration be halted unexpectedly (due to power failure for
example) and the results have not been copied to the database, ProCal keeps a recovery
file, which can be reloaded. To reload this file the system ID number must be entered.

Other options from the file menu:

Print Test Summary

Prints a results summary type sheet showing only basic instrument details and readings
taken against % of spec. Very useful to show faulty ranges etc when passed on to a
different engineer or department for repair, or to show the user the problem ranges.

Print Job Sheet

Prints job sheet, which contains the instruments, details, the customer details etc.

Save and Exit

Goes straight to the certificate save screen. The certificate number can be noted down
onto the Job Label if one has been printed through ProCal-Track.

Check Instrument Traceability

Checks the reference instrument database for incomplete traceability information or
instruments, which are past their calibration date.
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ProCal Menus: Edit Menu

&= ProCal -

File Mas(® Control  Help Abouk

Job Information | @aﬁ {D

Instrument Information

The edit Menu allows access to the job information and Instrument information screens
below:

Job Information Screen

Virtual Job Sheet [System ID : T1AB3T1J6]

Tranzmille 2901 A

Job Info l | nist Details] Cert Addresz | Returned B_I,l] Dezpatch .ﬁ.ddress] Acceszones ] Service Details] Higtory ]

Job Number : 21863 Link | Service Details | Sub Contract Details| D@ Not Recall
. FDF
Date Received : 05,41 0,/2008
Onder] g arvice Type |I3 - Mew Instrument Test ﬂ
Order Humber : aooo30yy Wi —
_ IEWA Cert. Type : |.-'l'-. : Standard Calibration j
Invaice Mumber ; Docs Quats Stat
uiohe Skatus ; =
Dezpatch Date 2440472007 Add | J
Calibration Date:  05/10/2006 e || [AEt e
Calibration Due:  04/10/2007 L || Pt b =[]
Certificate Mo.:  CM13262 Cent Wharranty [ Mains Safety | Fast T/R: T
Status ; |.-5'-. - With custamer ﬂ Turmraround : |1 = | Days  Cal Interval: |52 | Weeks
U - | - | Customer
Commentz --»
it By : )
| Cloze || Print Menu |

Advanced Edit

From this screen all aspects of a specific job can be viewed and edited. From this menu
every aspect of the instruments information can be accessed.

Advanced Edit
Advanced Edit allows the user to change more intricate details about the instrument, such
as the signatory for the certificate, or the traceable instruments used during its calibration.

All the details of an instrument can be changed in this menu, so care should be taken that
important data is not lost, this function can be set to Administrator Access only. The list of
enterable data is long; this list contains the information for every part of the instruments
procession through Booking In, Calibration and its Despatch details.
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Instrument Information Screen

Calibration Information - Accredited Certificate

Instrument Information

E nvironmental Information

System ID Foom Temperature T
Customer Fef, tainz Woltage Yilks
Hurnidit =
b anufacturer _ Y 2R
Serial Murnber Mains Frequency :| Hz
Model Mumber  [3200HA Calibration Information
D ate of Receipt 21/10/2008
Cal. Interyal 52 vl Weeks D ate of Calibration 2570872009
Certificate Type Job Humber
|Accredited Certificate ﬂ Tested By | ﬂ
Customer Information
Cuztorner Manme
ITRANSMILLE LTD. ~||  addcontast |
Cuztorner Address
| Cancel | | << Back | | Mest »»

This menu enables the user to enter important information such as the System ID,
Certificate Type and customer details.
Without a certificate type selected ProCal will be unable to select the correct procedure for
the instrument. (More information can be found in the appendix).
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Control Menu

The control menu allows several functions to take place,
There are two ‘control’ menus, a short menu for procedures, which use manual control to
step on to the next test, and a longer menu for procedures, which use auto step.

= ProCal -

File Edit Bakllsi=l8 Help
!E‘-w.ﬁ.UTDSTEF‘[\"] & {I}
Ignore Fail
v Show Auko Safety Prompks Chrl+5
v Show Auto Connection Prompks

Edit Tests
v Run Calibration Tests

Finish Calibration {Review Results)
Abort Current Test

Abort Calibration Fun

Auto Step (Y) (only in menu when autostep set)

When Auto Step is selected, this function allows ProCal to automatically move onto the
next test. For this process to take place, the auto step function must have been selected for
the procedure, auto step can also be turned on through Control->AUTOSTEP.

If the procedure is for a close loop calibration then this will be checked to allow it to run
automatically.

Note: If the user only wishes to run one test, then auto step should be turned off.
Autostep can be very useful even on manual instruments like decade boxes. Here the
Autostep condition can be set to proceed on to the next test if the measurement is within

specifications, this will allow the operator to simply switch round the values, with ProCal
automatically proceeding to the next test when it has the correct value.

Ignore Fail (only in menu when autostep set)

This will allow ProCal to proceed on to the next test even if the test fails. This is required
when an instrument is out of specification and it is required to let the ProCal procedure run
through taking all the measurements without stopping.

Show Auto Safety Prompts

Selecting prompts allows ProCal to automatically display safety warnings before any test
where the output from the calibrator is higher than 200 Volts or 2Amps, before the
procedure will move on the operator must click the ‘OK’ button within the message box.

Show Auto Connection Prompts
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Set Current Test to Non Printing

Selecting this will prevent individual test results being printed on the certificate. May be
used where a limited calibration is being performed.

Edit Test

The Edit Test function can be accessed via the ‘Control’ Menu. This function allows the
user to modify parts of tests, and to delete tests that have are not needed by highlighting
the relevant test/line and then clicking ‘Clear

Test
2 Edit Test Data

o | Te=st Title | Test Walue | Print Type -
1 | GENERLL TE3TS | | -—— TITLE --
2 | Diszplay | | Yesz

3 | Controls | | Yesz

4 | 240/110V Socket | | Tes

& | Blank Line | | —- BLANE --
£ | Earth Bond | | -—— TITLE --
7 | Z64 | | Tes

= | &h | | Tes

a | 100k | | Tes

10 | EBlank Line | | —- BLANE --
11 | DO.1FR B 84 | | Tes

1z | D.5R ® 8Si | | Tes

13 | 1R @ B4 | | Tes

14 | EBElank Line | | —- BLANE --
15 | P-N Fuze Continuity | | ——- TITLE --
1g | P-N Fuze Test Fail | | Yesz

17 | P-N Fuze Test Paszs= | | Yesz

13 | Pass/Fail Lewvel | | Tes

19 | EBlank Line | | —- BLANE --
Z0 | Insulation Voltage | | ——- TITLE --
21 | 500V @ 1md | | Tes w

W
Clear Test[s]
Cloge

Modify Print Type(s)

If the ‘Modify Print Type(s)’ button is clicked, a new menu will open with eight options for the
user to choose from. The selected option from the list is entered into the text box, to save
click OK, to abort the current action click Cancel.
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Modify Test Print Types

Thiz function will alker the print type
of all tests highlighted in blue.

Cancel

Frint Types :

1 = Alwaysz Print Test

2 = Print Only if Failed

3 =Do Mot Print Test

4 = Comrnent Line

5 =Title Line

& = Blank Line

¥ =Fane Break

8 = Print Only if Completed

Fleaze enter a selection and click OF, to proceed or
Cancel to abort,

Run Calibration Tests

This will enable interaction to the external .exe program set in the procedure, allowing for
automatic adjustment of the instrument under calibration.

Note: This interaction is still conditional on the instruments error being larger than that set in the
procedure.

Finish Calibration (Review Results)

This option allows a direct step to the end of the procedure. A message box will display

how many tests are left.
Calibration Results X
'j Warning :
"

43 test(s) have not been completed,

Do ol wank to proceed?

Yes Mo

Abort Current Test

Halts the current test. Takes you to a list of all the test in the procedure, this list allows the
user to select which test to complete and in what order, from this menu hitting next will
allow the user to enter job comments, input the price and write an engineers report (if
needed).

Abort Calibration Run

Stops calibration and displays the below message:
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' Abort Calibration Run [$_<|

WARHNING : The calibration run is about to be aborted.

\-‘p Select

Continue Testing to continue calibrating
Save Resultz to save before ending the calibration
Dizcard Results to abort without saving the results

gEantinue Testing: | Save Results | | Dizard Results |

Select the required option; note there is a further ‘are you sure’ box after this if ‘Discard
results’ is clicked by mistake.

L] E This will discard the resulks - Are vou sure 7
L]

Yes Mo |

Help Menu

Used to display & view Technical Help File, Calibration Help and the Uncertainty Template.
Note if these files are not present they will be greyed out.

= ProCal -

File Edit Control BgE About
el @ IL@ YWiews Technical Help File

About
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PROCAL

MULTI DISCIPLINE CALIBRATION SOFTWARE

V4.07.1 : 0740752009
Fully Registered Version

Programs Path = C:\ProCal\Programs
Procedures Path = C:\ProCalProcedures
Certificates Path = C:A\ProCal\Certificates
Reports Path = C:ProCallReportsh,
Language Setting = English

TRAMSMILLE LTD = +44 (0] 13580 B30700 = EMail : software@ransmille.com = Web : wwwiransmille.com

Displays the start up screen showing the version number program & data paths, the data

paths can be changed by the user, but upon installation they are directed to the local drive
on the workstation.

ProCal Tweak

ProCal Tweak is a quick adjustment tool for ProCal. This menu can be accessed by clicking ‘About->ProCal
Tweak).

Settings

From here the user has access to the printer settings, and the choice of the ProEdit welcome screen, and
allows the choice of sounds within ProCal.

Settings lLInu:ertainties] .ﬁ.ppearance] .-'-‘-.dvanu:ed]

Shove ProE dit Welcome Screen [

Play Sounds within ProCal

[e.g. HY Ramping Up] B

Default Frinter ~ |HP Laserlet 1200 Series PCL v | jj

Uncertainties

The Uncertainties tab offers the ability to bypass the uncertainty calculations, although this option should be
carefully used

Settings  Uncertainties .-'-"-.ppearance] .i‘-.l:lvanl:ed]

Uncertainties Moize / Flicker Default l_
[&pplies only if 1 meazurerment zample set] # Counts

Bypazz Uncertainty Calculation [ For 20003000
Senes calbratarz
anly
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Appearance

From the user can change the appearance of ProCal, a new menu can chosen by clicking ‘Change’.

Settings] Uncertainties Appearance l.ﬁ.dvanced]

Background Pattern Change

Advanced

The Advanced tab provides the options to several settings including enabling uncertainties to be imported and
exported, and locking the environmental settings for the laboratory in Procal, e.g. the temperature.

Settings] Llncertaintiesl Appearance  Advanced

Debug Mode [ Tumnsz off serial comms for debugging
AS5232 Dizplay | Show R5232 Com screen for B seconds

“Web Procedure Export [T Enable web procedurs export rmode
[PraE dit)

Enable uncertainties to be imparted £
exported to 4 from procedures &
Procedure Werification

Enable Uncertainty r
Contral Fanel

Dizable Auto Archive

Mode [ProSet] [~ Dizable Auta Archive in ProSet

[Traceable Ingtrument / Uncertainty
Template EDIT]

Lock Erwiranmental r Lock ervironmental settings in PraCal
Settings in ProCal Instrument information screen
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Performing a Calibration with ProCal:

Starting the Calibration

ProCal offers several ways to start a calibration to work the way you wish to. Use the file
Menu to select the preferred way you wish to start the calibration.

The most popular method when running with ProCal Track is by Job number, which can be
entered or scanned from the bar code label printed when the instrument was booked via
ProCal Track.

If using ProCal by itself simply entering the serial number is often the preferred method.

‘ Note: The default start up screen can be set in ProSet File>options. (Page15)

The Calibration Information screen details the instrument, environmental and calibration
information.

Calibration Information - Accredited Certificate

Instrument Information Environmental Information

Syztem 1D Foom Temperature | U

Customer Ref. Mains Yaltage | Walts
Hurmidit | =

bd anufacturer _ ¥ %RH

S erial Number b ainz Frequency | Hz

Model Mumber  [3200HA Calibration Information

l—_| Date of Receipt 21/10/2008
Cal Interval 22 T | Wesks D ate af Calibration 2570842003
Certificate Type Jab Mumber
|A.-::-::ledited Certificate ﬂ izl | j

Customer Information
Custarmer Mame

ITRANSMILLE LTD. ~||  AddContact |

Customer Address

| Cancel | << Back | | MHest >

complete this form with the instruments details and environmental information, the
calibration information will be filled in automatically once calibration is complete.

This data will all be completed from the database if the instrument is on the database
because it has been booked in by ProCal track or because it was previously known.

Note: You cannot leave this screen until the serial number and the calibration interval have been filled
in.

The environmental information will be remembered from the previous calibration.
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Note: The variation, e.g. +/-1°C printed on certificates is entered in ProSet.

Customer information can be stored in the customer database by entering the details of a
customer and clicking ‘Add Contact’ button, which will add this customer to a drop down list
to save re-typing frequently used addresses.

Selecting the Procedure

ProCal will automatically search for procedures, which match the model number and the
type of certificate required, Standard, Accredited etc, and if there are several, it will
highlight the one used last time.

Please confirm the procedure for instrument T00941218"

M. b anufacturer tdodel Drescription Werzion
3574 Transmille 3200H Electrical Test Calibrato 3.3/H
Procedure Type : |Ac:-::redited Certificate j
Eancei | Wiew Technical File Search | | << Back | | Hewt =

Use the ‘Search’ button to manually search for a procedure if required.

Note: That ProCal uses the Procedure TYPE selected in the search and will only list that TYPE.

Use the ‘Technical Help file’ to keep notes on procedures. Then if there are several
procedures for one instrument it can be viewed to help select the correct procedure.
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Traceable Reference Instruments & Uncertainty Statements.

The list of Reference instruments used in the selected procedure and also the uncertainty
statements will be displayed in the below table.

Note: That ‘none’ may be displayed in the uncertainty box if the procedure is using individual
uncertainties.

Confirm Procedure Settings - Transmille 3200H procedure [PROC3574]

%7 TRACEABILITY INFORMATION
Thiz procedure uses the following traceable instruments
Hone Selected
%% UNCERTAINTY STATEMENTS
Procedure uses individual, comment line or aunto-calculation uncertainties
Is the information listed above correct 7
Mo Yes

Note: Traceability information, calibration date etc, on the reference instruments used in this calibration
is copied from the Instrument Traceability table in ProSet to the certificate file. The calibration will be
halted if any reference instrument used is past its calibration date.

Address of Device under Calibration

If the procedure has been written to calibrate a UUT (Unit Under Test) using an interface
connection either GPIB (IEEE488) or serial COM, then ProCal will ask for the
address/COM port of that instrument.
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T UUT COM / GPIB :: Cal Run Options X

~?r“' Fleaze zelect a COM Port / GPIB Address

»¥» Select COMT to COME for Serial Communicatio
»»» Select 0 to 30 for GRIB Communication.

COM1 ~

A4
.  RUNCALIBRATION TESTS

Before or After Adjustment

This screen allows the user to select whether the results to be taken are the before or as
found or after adjustment. Normally the user will select first as Found readings, then if
required make adjustments and return to the procedure then take another set of ‘After
Adjustment’ readings. ProCal will know the ‘As Found’ results have been already taken and
this option will be greyed out when returning to take the results.

Both As Found and After Adjustment Results will be on the same certificate in this case. ‘

If required the user may select directly the ‘After-Adjustments’ results, for example when
the instrument had to be repaired first before any as found readings could be taken.

In exceptional circumstances it is possible to also select to make two certificates, one for
before and one for after results. As this is not the normal way, ProCal will prompt you with
an ‘are you sure’ message box.
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Calibration Options

\-i.-—*" Select one of the available options below, then click 'Mext »»'to proceed or << Back'.

:fl;g " As Found Readings
»_;‘l)_g " After Adjustment Readings

Select Optional Sections [4 available]

Cusgtomer Comments

<¢ Back ‘ |

Comments from the ‘customer comment box’ on the virtual job sheet are also displayed at
this time. These may have been entered when the instrument was booked in. This is to
bring to notice any special requirements asked for by the customer.

If existing results are found for an instrument, ProCal will ask the user to either attach the

current ‘As Found’ results onto the same certificate as the new ‘After Adjustment’ results,
or to have the ‘After Adjustment’ results saved onto a new certificate.

Existing Results Found For Instrument

g & Append the After Adjuztment results ;
1 to the Az Found certificate.

3 ~ Save the After Adjustment results on
1 a MEW certificate.

LCancel ¢ Back ‘ ‘

ProCal Measurement Tests

ProCal is now running the procedure as created in ProEdit. The procedure will contain
many different types of test depending on the requirement for that test.
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The measurement screen is very similar however for all types of test. This screen will
display the tests in the procedure, of about which 10 can be viewed at one time, use the
scroll bar to view all.

Normally a procedure will be started at test one and will run in sequence through to the
end. However it is possible to jump to any test simply by clicking on it in the test list. (Note
title tests and print formatting tests cannot be run).

Clicking the ‘hand’ symbol in the toolbar at the top stops a test running.

The Prompt Screen in ProCal

The prompt screen is displayed before a test if set in the procedure.

The information can be simply a typed message, a bitmap picture or even a video file. The
prompt screen is there to inform the operator of the required connections, instrument
settings etc.

Before Test Prompt Screen

50mV D.C. Range

Test No. 7

Select D.C. mV Function

irefl=Jl= Il =|l=|
HEEEE
FEARAERE

ﬂEE'EIEIEl

FIEEEG

1) Conmect calibrators output to Meters voliage mput
U s low the-ralleads with gold plugs for voltages below 1V oht
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Basic Test Types in ProCal

Running a Pass /Fail Test

Manual Input - As Found - Procedure
Test 2 : Display Check

|2 the dizplay funchtioning correcty?

Mo, | Test Title Test Yalue Reading % Spec
Cenerzal Tests
Diaplay Check
Dicde Check B

[

400V D.C. RANCE
400V Range
Range

400V Range

400V Range
0 400V Range

YES NO

Cal Help | | Bestart Test

How 00 -] @y o= L
.
=)
=)
<

4

~
o
-,

o

r,
.
.

Ewpected Fesult YES

Simple click on the result, ProCal will automatically advance to the next test.

ProCal User Manual V4.00 Page 50




Procal Calibration Software: User Manual

Running Meter type test: Using a calibrator

In this test the computer will set the system calibrator to the output set in the procedure.
The operator will enter the reading displayed on the meter usually using the keyboard for a
digital meter, or by slewing the output of the calibrator to align the pointer of an analogue
meter to a scale mark.

Alternatively the reading from the meter under test may be read back using a GPIB
(IEEE488) or serial interface. This type of calibration is called ‘closed loop’. ProCal can
even control the range and setting of the instrument under calibration, if it is entered into
the procedure.

Multimeter Calibration - After Adjustment - Procedure

Test 10 : -590V

whARMING! - HIGH WOLTAGE [-5900) autput test.
Enter value dizplayed an meter [withaut uniks],

Mo, | Test Title TestYWalue Feading % Spec [B] % Spec [F]

General Tests A
Display _— =
Controls —_——
Bleeper Test _—
Mace/Min _——
Zerc ODC Current —_——
Inrush —_——

=1 & N W= L kB

o
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
[ae]
=
5
-
[
=
m
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

E OC Voltage
10 -530V 5

Manual Input > || < Manual Input

-BA0m

= 1 1 1 1 1 1 1 1 1 +
Al Vo LETG T UT T U0 E UL T TR rm i D UG T, 1

T

| Eault | | LCalHelp | | Bestart Test | |

Testalue |-530.00 ncertainty | 210

The bar graph display on the screen clearly shows the error related to the instrument under
the test specifications in a graphical manner.

The width of the uncertainty band is also graphically shown as arrowheads extending to the
left and right of the measurement pointer.

The result of the test is shown in the top right corner of the window.
Four possible results will be shown as described below

Pass: - Instrument passes regardless of measurement uncertainties
Probable Pass: Instrument could be out of specification allowing for uncertainty
Probabile Fail: Instrument could be in specification allowing for uncertainty
Fail: Instrument fails regardless of measurement uncertainties
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Uncertainty Calculation

To view the Uncertainty calculation window click on the ‘UNCERTS’ button whilst on the
above menu.

Note: This button will only appear if there are no uncertainty statements selected for the procedure and
there is no data in the ‘uncertainty box’.

It is necessary to enter numerical value in the ‘noise/flicker’ drop down box to obtain an
accurate calculation of uncertainty.

@ M3003 Uncertaintiez Calculation Uzing "‘DCY Source' Uncertainty Template

Source of Uncertainty Limit Value E::tl:lahl::tl:gl Divisor | C; zl;
Impoarted Lncertainty 2) 1.6uy Maormal 20 1.0 0.8uY
otability of Reference 2) 950 Rectangular 13 1.0 550
Feszolution 2 10.0u% Fectangular 13 1.0 5.8uv
Maoise / Flicker 10U Mormal 1.0 1.0 | 10.00%
Connection / Lead Errors 0.5u% Rectangular 13 1.0 | 288.7nY
Combined Standard Uncertainty Mormal 12.8uY
Expanded Uncerainty Mormal (k=2) 2Bu
20064 Precision butti-Product Calibrator [ emrsw |
Line 2 [DCY : 202m%'te 2.02%] - Calibration = 000023 % : Stability = 0.0007% + Gu ‘Llose

The Template for this spread sheet is ‘DCV source’ created in ProSet.

1: Imported Uncertainty is calculated at run time from data in the Uncertainty file created
in ProSet for the calibrator in use. The figure is calculated by combining the Zero (Floor)

and the % of reading (Gain) using root-sum of squares form the ‘Calibration of reference’
column.

ProCal User Manual V4.00 Page 52



Procal Calibration Software: User Manual

2: Stability of Reference is calculated at run time from data in the Uncertainty file created
in ProSet for the calibrator in use. The figure is calculated combining the Zero (Floor) and
the % of reading (Gain) using root-sum of squares from the ‘Stability of Reference’ column.
The data used must be entered in ProSet as K=2, 95% confidence level with infinite
degrees of freedom.

3: Resolution is taken from the number set in the D.P (Decimal points box), in the test
data for that test in ProEdit.

4: Noise/Flicker or the short term repeatability of a manual instrument, for example a hand
held DMM must be observed by the operator and entered in the Noise/flicker drop down
box at the bottom of the screen.

5: Connection Lead errors are taken directly from the DCV source template created in
ProSet.

These values are then combined at run time using the standard method in GUM, M3003
etc as called for by ISO17025 to produce a dynamically calculated figure for uncertainty for
95% for each test reading. For quality audits this visual approach allows all the calculations
to be easily verified.

Note: The automated calculation assumes that there are no dominate terms and all contributions have
infinite degrees of freedom.
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Running a Measurement Test: using a DMM to take the reading

This type of test controls & reads from the system DMM (Digital Multi Meter) using the
GPIB or serial interface to automatically make a measurement.

Typically it would be used for calibrating a voltage source or measuring the output from a
process control calibrator.

The system DMM must first be selected from the available models in the drop down list in
line 2 of the Traceable instruments table in ProSet.

If the type of DMM needed is not supported in this list then it may be possible to order a
custom driver to support your DMM. Alternatively use a general test to read a DMM using
the command window to control the DMM

There are three advantages of using a driver to communicate with the DMM,

1: Avoids writing interface code in the procedure, which can be difficult and generally
requires a  higher level of understanding of controlling instruments.

2: With a driver all that is required to update the system DMM at a future date is to change
the selection in the Traceable instruments table in ProSet.

3: A driver for the same procedure may be used on two or more systems with different
models of DMM.

Note: Additional control commands can still be sent to the system DMM using the command window.
Also commands to control the unit under test (UUT) can be sent which makes writing a closed loop
procedure very simple. See ProEdit — command window.

The measured value is displayed in the same graphical way as the meter test above (Page
47), the only difference is that the reading is being read automatically from the system
DMM, as opposed to the meter test above where the reading is being either entered
manually using the keyboard or being read back from the UUT over the interface. The
reading, Pass & Fail results, and uncertainties are displayed the same.

Running a General Test

A general test is different from the above oscilloscope, meter and measurement tests etc in
three ways: -

1: There is no ‘built in’ control of any instrumentation. Only using the command window
controls the test.

2: There is also no Default reference instrument. This must be selected in the procedure.
3: There are no predefined units, e.g. volts,

Note: Every element of the procedure will need to be selected by the user
These differences allow a general test to be written for almost any calibration, using any

reference in the Traceable instruments table, where there is a nominal value and a reading
with a pass/fail tolerance.
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For example calibrating a pressure gauge using a dead weight tester. Neither instrument
is controlled in any way by the software, but a pressure is applied and a reading taken.

Manual Input - As Found - Procedure PROC20

Test 2 : 10Bar TEST PASSED

Enter reading dizplayed on instrurment

Mo, Test Title TestYWalue Feading % Spec

Pressure Bizing

b Preszsure Falling
10 30Bar

Manual Input > ||]5_9‘ < Manual Input

: T0UEar
= 1 1 1 1 1 1 1 1 1 +
AT T T L bR S A g DR B
1 1 1 1 1 1 1 1

1
| Eault | | LCal Help | | Bestart Test | | MHest =

TestWalue (10.0Bar 20% 0f Spec.

With this test type the result can be entered the same as any other reading and a certificate
can still be produced, the only difference is the user has to manually enter the test results
and conduct the test themselves instead of allowing the software to control the test This
makes ProCal a universal solution for calibration software throughout the calibration
laboratory.

Note: The Test Value box can be typed into, to change the Nominal test value if not correct for tests
where the actual value cannot be known until the test is run.

Running other test types

The other test types all follow the same format as the tests mentioned in the preceding
examples e.g. they will either be a variant of a meter test, where the calibrator is set by the
computer and a reading value is to be entered, a measurement type test where the
computer will use an instrument to take the reading or a general test.

See the ProEdit section for details of how each test type is used.
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Finishing The Calibration

After all the measurements have been taken and the instrument has passed calibration, the
certificate comments should be edited. ProCal will copy comments in the procedure across
automatically. Simply type in the relevant comments or use the drop down boxes to add
further comments.

Certificate Comments

.jg Enter ary required certificate comments below - to impart an external test file click on ‘lmpaort
Comments' and select the required file. To edit the contents of the 'drop down' listz click on
the button marked *...'

|Instrumenl was allowed to stabilise for at least 12 hours before calihratiuj \:I

|AII ranges were nulled prior to calibration ﬂ \:l

|4 Wire ohms connection was used on values up to 10 kohms j \:l
| =[]
| =]

<¢ Back ‘ | MHest »»

Note: To edit the content of the drop down boxes click the button ‘...’
Notepad will allow you to edit the file & save. The new text will only appear once the current screen has
been closed and reopened.

Job information

Details of any parts used, prices, and an engineers report on any repair work are now
entered.

Note: That the Job comments print on the service log, and that the engineers report can be
used on a crystal report to inform the customer of any further details about the instrument.

ProCal User Manual V4.00 Page 56



Procal Calibration Software: User Manual

Job Information

\j‘_j Enter any required job information below, To edit the contents of the 'drop down' lists click on the button mark§
Services l Parts USEd] Engineers Repart | Jaob Eumments] Quote ] Total Parts Cost
Service Dezcnphion Qty Coszt [Each] £ DI:”:I
Calibration |Digital 8.5 =1 - £214.00 ;EEE";] Egﬂ
Repair | = - £ -
| = | j f Calibration Cost
Additional { | = s £21400
Services o
Fepair Time [Hours]
| = ¢
Cal. / Test Time
Engineer
Edit Partz List
¢ Back | e

From here the costs for repairs and additional services can be added using the green cross
button, this will open a new menu which contains a list of options, once the correct option is
selected the new costs will be visible in the Services tab.

Setting the Instrument status at the end of calibration

Each instrument in the database has a status, which enables ProCal to keep track of what
is happening to it and where it is in the calibration cycle. Before saving the results this

status can be set.

Note: Calibration complete cannot be selected, as the instrument requires adjustment.
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Instrument Status Information

,_E_J Select an instrument status from the available options belaw,

Instrument Status Selection

{+ Calibration Complete:

" Adjustment Required
" Awaiting Customer Response / Information
(™ Calibration Incomplete

" Other
Run a Report j Bun Report

Instrument Priority - Adjust Turn Around Time

T A d Ti 5 ~| D
Hin Around Time ] Darte) Instrument is due on 07/09/2009

Date Received :

| <¢ Back | ‘ Mewst »»

From here a crystal report can also be generated which can be sent directly to the
instruments owner to inform them, of any problems, see Calibration fault report.

If the calibration has not been completed then the ‘Calibration Complete’ option will be
greyed out.

From the turn around time for an instrument can be updated, this means if an instruments
needs repairs or adjustments the number of days can be changed to help keep track of
instruments on the priority list.

Assigning the certificate number

ProCal will get the next number for the type of certificate produced (based on the
procedure used) from the counters set in ProSet. The number is obtained at the completion
of calibration to avoid having unused numbers if the calibration is aborted mid-test.

The user can type over the automatically generated certificate number to use a custom
number.

A warning message will be given if a duplicate number is entered.
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Set Certificate Number & Save Calibration

i) Check the certificate number below. IF not acceptable, change to the required number and then
click Einizh' to zave the calibration.

Mate : If the certificate number alieady exists a warning will be shown and another number map
be chogen,

Certific.ate Mumber

CM19689

< Back | | Finizh

Note: Use the back button to return to any previous screen

Click finish to complete the calibration and save the certificate number.
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ProEdit: Managing Procedures

Overview and Introduction

ProEdit’s prime function is to create and edit calibration procedures used by ProCal.

A procedure is made from a header, which contains information about model numbers,
instrument manufacturers etc, followed by any number of individual tests. The use of in
built wizards allows easy and rapid generation of procedures based on generic type
instruments.

ProEdit also manages the procedure library. Allowing procedures to be copied, printed and
deleted. In addition ProEdit can upload to its library, procedures which can be downloaded
from the Transmille website.

Note: For this function to work a key code from Transmille must first be purchased.

ProEdit will be installed as part of the ProCal suite but can be run as a stand alone
program, enabling procedures to be worked on remotely from the calibration station.

Procedures are stored in Microsoft Access as individual files in .mob format. There is also
an index file, which logs the procedures in the library.

ProEdit Shortcuts

To have this menu open on start-up, click Help->Show Welcome Screen’ and tick the box
in the lower left corner. This menu does not need to be used; the same functions can be
accessed via the normal menu.

B¥ Welcome to ProEdit

EDIT EXESTING

PROEDIT 3

Create a NEW Edit an EXISTING Search for a
Procedure Procedure Procedure
\& Start Procedure
= Wizard

Show this screen at startup

From this menu the user can ‘Create a NEW Procedure’ detailed instructions on this
function can be found on Page 68. The users can also ‘Edit an EXISITNG Procedure’ with
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detailed instructions on Page 65. The user can also ‘Search for a Procedure’ via this menu.
The final option allows the user to ‘Start Procedure Wizard’ for which detailed instructions
can be found on Page 66.

ProEdit Menus

The File Menu
The main file menu allows basic controls for creating, editing and copying procedures etc.

¥ ProEdit [User Name= : User Level=ADMINISTRATOR

3=l Utilities User Login  Help

Create Mew Procedurs Cirl+M = =
maE e = =

Edit An Existing Procedure Ctrl+E

Procedure Builder Wizard »

Print Procedure(s) Cirl+F

Copy a Procedure
Delete Procedure(s)

Exit

Create a New Procedure
Selecting File ->Create New Procedure will open up a new menu allowing the user to
create a procedure without using the wizard, a detailed guide can be found on page 68.

Edit an Existing Procedure

Select File->Edit an Existing Procedure if changes or updates need to be made to a
procedure, changes can be made to any part of a procedure, a detailed guide can be found
on Page 65.

Procedure Builder Wizard

Selecting File->Procedure Builder Wizard opens a new menu with a series of images
depicting various instruments that have pre-written procedures, a detailed guide can be
found on Page 66.

The Utility Menu

: User Level-ADMINISTRATOR]

File BELE(EEN User Login  Help

Edit Uncertainty Skakements n A
SR

Expart Procedures
Impart Procedures

Edit Cuskam Lisks K

Wiew | Edit Procedure Costings

Advanced Compack & Update all Procedures
Archive Procedure Before Editing
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The Utilities menu allows access to the functions in the above image, ‘Import Web

Procedures’ will only be greyed out if a key code hasn’t be acquired from Transmille.

Edit Uncertainty Statements

¥ ProEdit [User Name-

File R0 ser Login  Help

Edit Uncertainty Statements

Export Procedures
Import Procedures

Edit Custom Lists »
View [ Edit Procedure Costings

Advanced r

Selecting Utilities->Edit Uncertainty Statements allows the uncertainty statements, which
can be selected in a procedure and printed on the certificate to be created and edited. A
default table is loaded when installed, but new lines can be added to suit the requirements
of an instrument.

Note: This table is only used if uncertainty statements are selected in procedures. Otherwise individual

uncertainties will print.

[ T TR e T o Y S P i ¥

10
"
12

Uncertainty Statements

1: D.C. Voltage ~

AT Vaoltage
D .C. Current
A C. Current
FResistance
Capacitance
Inductance
Amplitude
Timehase
Frequency

Analogue Pressure

Time

\jr} To edit gtaterments or the uncertainty statement name, click on the required statement line fram the list.
Mate:- The first ten itemz have fixed titles, if a custom line is required lines 11+ should be used.

Currently Selected :- Line : 1

|D.E. Yoltage

Incertainties For D.C. Voltage

|D to 10000 0.002% + 1digit

| Add Mew Line

Search For Procedures | Exit
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Note: A procedure only uses the line number of a statement. If the order of statements in this table is
changed, a previously written procedure will transfer the new statement, which may be incorrect.
Example: If the statement for AC volts were replaced with RPM any procedure that had AC volts
originally selected would now transfer the RPM statement to the certificate when used.

On Networked systems it should be remembered that this table is on the local C: drive, (as each system
will require its own uncertainties) care should be taken to ensure the order of this table is the same for
each workstation. Otherwise a procedure will select the incorrect statements on some stations.

To check which procedures use a particular statement use the ‘search for procedures’ button

Export Procedures

This function allows the selected procedures to be exported to back up the data, or to be
transferred to another system.

Import Procedures

This function enables procedures that have been exported by the above method to then be
re-imported onto the system.

Import Procedure(s)

Select Drive & Folder: Select File(s)

j:‘" Toload all filez, leawve selection blank.

| S [08] |

S0
_ S PraCal

& Procedures
L1187 [PROC2]
[C1187 [PROCA]
[C3 200 [PROC1S1]
[C 344014 [PROCT]

|E:’\F‘m[ﬁa|\F’rocedures Cancel ‘ | ok

Import Web Procedures

The import Web Procedures function is for unzipping compressed procedures downloaded
from the www.transmille.com web site and adding them to the procedure library on your
system.

Note: This function must be enabled first by obtaining a ‘Key code’ from Transmille, which must be
entered in the ‘About’ menu in ProEdit.
Without this code this function will be greyed out.
Procedure files downloaded from the web site cannot be used without this function, as they cannot be
loaded and saved into the Procedure library.

1) To navigate to the procedures available for download, please go to www.transmille.com
then click on Software, which is located on the top menu.

2) On this new web page are three boxes, within the left box containing information on
ProCal, there is a link titled ProCal Procedure Library.

3) The ProCal Procedure Library will take you to a new page with two options Free
Calibration Procedures and Full Procedure Library
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Note: The full procedure library is freely available to those who are a Web Downloads
Service Subscriber. To subscribe to this full service there will be a fee.

Please follow the steps below to IMPORT WEB procedures into your system.

STEP 1

Download one or more of the required procedures by clicking the Download hyperlink next
to the procedure you require, then choose Save To Disk.

K E |

Saveine | (2] Deskiop = & & =l = E

=y Computer

by Docusments
Mebacek, Meighbodood
] Onbrie Sesvices

1 | L]
File pame: IMEGGER Chis00 Installation tester MO_ Sanem I

Save az hpe: I".'LIII'III_ d Cancel Lﬁi

Save the file (e.g. MEGGER CM500 Installation tester WD ) to a folder (directory) on your
computer.
REPEAT THIS FOR EACH PROCEDURE YOU REQUIRE FROM THE WEBSITE

STEP 2

To IMPORT these procedures into your ProCal system, ProEdit must be used.

Start up ProEdit and select the UTILITIES MENU, then select IMPORT WEB
PROCEDURES (this is different to the IMPORT PROCEDURES function, which does not
recognise subscription procedures).

Impoart WEB Procedures

Select Driwe & Folder Selact Fila(s)
¥ Toload all files., leave s=hection blank

IIQE j WEGGER Chis00 Installation Tester.uirD_

[ mebes procedues [15 catalogus) =]
[ o

) procedures

[ programns

[ quetes

[ quokes ]
[ web procadunes
-

r?:‘-PmEaMndJ dowriinads | Carvel | t 0k |
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Select the folder you saved the subscription procedures to, then select the procedures by
highlighting them on the right hand side of the screen. Click OK to start importing.

ProEdit will now IMPORT all of the selected procedures.

Edit Custom Lists

Opens with notepad either the ‘Manufacturers list’ or ‘Instrument description list for editing.
These lists are used in the drop down boxes. The data in the drop down boxes will no be
updated

View Edit procedure costing

Opens a list box showing procedures with the option to edit the price/code field.

Advanced

Offers the option to compact and update procedures to the archive for backup. Also allows
the user to archive a copy of a procedure before it is edited.

Writing and Editing procedures with ProEdit

A ProCal procedure is made up of a header and a series of tests.
New procedures can be created in three ways: -

1: By Using the Wizards
2: By editing an existing procedure
3: By writing it line by line
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Procedure Builder Wizard

By using ProEdit, the user can create procedures very easily and quickly by using the
inbuilt wizard, which can be used to build a basic procedure for a generic instrument type.
If an instrument combines several functions such as a Loop and RCD tester, the wizard
can actually amend the second instrument tests to an existing procedure, negating the
need to create a new procedure

If extra tests or changes to the specification need to be made then using the edit function
within ProEdit can perform this.

From this screen select the instrument you wish to create a procedure for -

"3 Procedure Builder Wizard

3¢ Please select an instrument type...

MULTIMETER OSCILLOSCOPE POWER SUPPLY PROCESS

CONTROL METERS  CLAMP METER

- N

CONTINUITY & RCD TESTER PORTABLE LOOP TESTER THERMOCOUPLE
INSULATION APPLIANCE
TESTER TESTER
(R | =c==| || LT
‘& —
PRESSURE PRESSURE TORQUE SIGHAL
INDICATOR TRAMNSMITTER [EEHOMETER METER GEMNERATOR

Selecting the MultiMeter image will open the menu below.
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Wizard for a Multi meter: -

To create a Procedure for a DMM (Digital Multi Meter) complete this form and click ‘Build

Procedure’

"% Procedure Builder Wizard : Multimeter

Model Wersion
M anufacturer | e | Myl
@ Meter Display | -
© Furciion Fange Infarmation Instrument Specifications
Loweszt A ange Highest Fange % 0f Reading % 0f Range + Mo, Of Countz

ey |0l |l =l | |
acv (o] =] | | |
BIC i =l|l =l | |
Ao (o] =] | | |
S ol — | —" | |
CAPS || =l = | |
FREQ | | |l || | |

|_ Lirearity Linearity I—L| Limearity I—L|

Function Fiange Step
Additional Checks Cortinuity Bleeper Dinde Test Bar Display

4] W O O
| E it lze Feyboard Entry For All Tests v * MNew ELild P 4

M I1ze Uncertainty Statementsz v O Apperd Ll PR

Each separate wizard is used in the same manner to create procedures for different instruments.
Choosing a different instrument within the Wizard will open a different form; each one details the
individual information that is needed to build the procedure.
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Editing a Procedure

Once a procedure has been created it can be very easily edited. Tests can be deleted,
copied, inserted & pasted which enables tests to be quickly duplicated and edited.

Note: A test can be dynamically edited using ProEdit whilst at the same time running that test in ProCal.
In this way a test can be corrected in ProEdit, saved back to the database by using ‘copy test’ button,
and then run directly by ProCal by using ‘restart test’. This provides a very quick method to De-bug a

procedure.
Note: An error will be generated if a test is added or deleted in a procedure by ProEdit when ProCal is
running that procedure.

Each test in a ProCal procedure is independent, containing all the data required for that
procedure and no other.

Select Procedure [Edit Mode]

Procedure Humlber Manufacturer

v Standard
v Accredited

@) Select Mocredited,
Standard or bath.

| Start Search |

| Exit |

Maodel Humiber

Date Created / Edited

Procedure Humber (m
Acculab ~
Version Humber (“ 1239 Act
Advance
Agilent
Manufacturer (“ .-’-'-.E:;:ﬁgnn
Procedure Version a0IF
Description . Appa
AN Power Ltd
Model Humiber '
Date Created Edited [“ Description

21080 Current Clamp Adaptor
3 Phase Supply

Ak [nsulation &daptor
AC Microvolt Meter
AC/DC Digital Multimeter
Armnmeter

A procedure can be searched for by any one of the above methods, the description of the
instrument and the manufacturer can be chosen via the scroll bar or by entering the name
manually. Procedures can also be found by selecting if it is a Standard or Accredited
procedure using the tick boxes, this option will load a seperate list of all accredited or
standard procedures.
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If the procedure is found a new menu will open allowing the user to select the correct
procedure if more than has appeared depending on the search options used.

Select Procedure [Edit Mode]
Procedure Search Results

1 Matchies) Found.

M. Inztrument Description

 arufacturer

Model Mumber | Werzion Murmber

1299 | Cable Analyser

»» Ordered By Procedure Mumber

Transmille | GHCE3554 1 210

Frint List

Exit | | Fe-Search

| | pdate

Double click the procedure, or select it and click ‘Accept’, if the wrong procedure is found
then click ‘Re-Search’ to find the correct one.

The Procedure instrument Information menu will be opened, all information can then be
edited and updated, the next menu will contain the Uncertainty statements and Traceable
instruments that can be changed and updated if required. The final menu contains the tests
of which all can be edited, to finish editing a procedure just click ‘Done’. Editing a procedure
follows the same outline as creating a new procedure.
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Create new Procedure

After selecting ‘create new procedure’ the user is first asked if they are sure they wish to
create a new procedure, after selecting “Yes” the user will have the below form to fill in with

the details of the procedure and the instrument.

The Procedure Header Page: -

Procedure Instrument Information (Proc 4490)

[nztrument Description b arufacturer

Model Humber Yergion Humber Cerificate Type Date Created / Edited  Las
| | |Standan:| Certificate ﬂ | ﬂ

Verified |

Comment Line 1 |

Cormment Line 2 | (" % of Spec.

Comment Line 3 |

(8 Pazz / Fail

Comment Line 4 |

Ll Ll Led L e

Comment Line & |

Column Headings | Reset To Default | Fricing
| Frice / Stock Code

Applied Yalue Title

Tolerance Title | |

Reading Title |

| | | Privt Pracedure | Wiew Techhical File

Instrument Description

Import Comments

Use this field to describe instrument functions, this will be printed on the certificate and
MUST be completed.

Note: The drop down box can be edited in the utilities menu.

Manufacturer

Used to highlight the manufacturer of the instrument, this will be printed on the certificate

and MUST be completed.

Note: The drop down box can be edited in the utilities menu.

Model Number

This field is for the model number of the instrument and is very important, as the model

number used in the procedure must match for ProCal to automatically search for it. Itis a
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good idea to have a ‘company standard’ method to deal with spaces in model numbers and
the use of Roman numerals when entering a model number.

Note: That any digital ID images and that the Technical help notepad file are linked to the procedure by
model number. Changing model numbers here will require these files to also be renamed and updated.

Version Number

Used to identify the version of the procedure. Note that when editing a procedure there is
an automatic archive option available. The archive option allows the user to save a copy of
a procedure before it is edited; this is a valuable function of ProEdit.

Certificate Type

Used to select the type of calibration and certificate that this procedure will produce.

This selection sets both the certificate print style and also to only list procedures in ProCal
which match the certificate/report style set for the instrument, as set in ProCal or ProCal-
Track.

For example: Only procedures for standard calibration will be listed for an instrument which has been
booked in for standard calibration, whereas an instrument which has been booked in for an Accredited
calibration will only have the Accredited 1ISO17025 procedures listed. This stops the accidental selection
of the wrong type of certificate format.

Note there are 5 different certificate/reports available:

Standard Certificate
Accredited Certificate
Certificate of Conformance
Electrical Safety Test

Test Report

None

Each with its own certificate number counter as set in ProSet. Any particular model may
have for example both a standard certificate procedure, and an ISO17025 accredited style
procedure with different test points, uncertainties comments etc. This allows the laboratory
to provide complete flexibility in the choice of services it provides.

A separate counter is used for each type of certificate/report, allowing for the sequential
numbering of certificates.

The Test report is of particular interest for hire equipment as it allows a short procedure to
be used as a quick check before or after hire, whilst the certificate procedure allows for a
full annual calibration.

Date Created

Used to log the date that a procedure is written.

Note: Use the Technical help file to keep details of the procedure history.
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Date last Used

Automatically filled in by ProCal when used, useful when checking on the usage of a
procedure.

Notes (Technical File)

Short text field used for procedure notes, e.g. special version. Use the Technical help file to
keep longer notes.

Note: That the Technical note file is a simple text file edited by Windows notepad, and is automatically
created by ProCal as model number .txt from a template file.
This file can be easily viewed and edited from many screens in ProCal simply by clicking on the ‘View
Technical File’ button. It is very handy for keeping all sorts of notes relating to that instrument.

Report File Name

If a special style of certificate/report is required for this procedure then a crystal report file
name can be entered here and this will always be used for any certificate produced by this
procedure.

Comment Fields

Any comments made in these 5 lines will be copied across to the certificate when this
procedure is used. These lines can be edited before the certificate is saved. This can save
time and also mistakes.

Print Options

Set on standard certificates where a test result will be printed as pass/fail or as a
percentage of specifications figure. The majority of quality mangers prefer to see Pass/fail
printed.

Column Headings

Sets the titles printed at the top of each measurement page on the printed certificates.

Price / Code

Sets the Price of a calibration using this procedure, this information is then transferred to
ProCal track and used for Job costing and invoicing later.
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Procedure uncertainty statements and Traceable reference instruments used.

Procedure Instrument Information, (Proc B3)

Uncertainty Statements
Flease selectthe uncerainty staterments required to be printed an the cerificate (note : these
printed if the procedure uses individual uncerainties for each test).

IIncertainty Line 1 |1 : D.C. Yoltage j IIncertainty Line B |“ Mot Selected =
Uncertainty Line 2 |2 - AC. Yoltage j IUncertainty Line 7 |“ Mot Selected =
U ncertainty Line 3 |3 : D.C. Current ﬂ IIncertainty Line & |“ Mot Selected ==
IIncertainty Line 4 |4 : A.C. Current ﬂ IIncertainty Line 9 |“ Mot Selected ==
IIncertainty Line 5 |5 : Resistance ﬂ IIncertainty Line 10 |“ Mot Selected ==

Traceable Calibration Instruments
Flease selectthe traceakle instruments required to be used for calibration. These will be printed
cetificate cover sheet (note : these instruments will not be printed on UKAS cedificates).

Inztrurnest 1 |l]1 :L: DEMO MODE ﬂ Instument 5 | == Mot Selected ==

Inztrument 2 [** Mot Selected == ﬂ Ingtument 7 | == Mot Selected ==

Inztrument 3 |** Mot Selected == ﬂ Ingtument 8 | == Mot Selected ==

Instrument 4 | Mot Selected == ﬂ Inetrument 8 Feserved For Unit Under Test [ Epable
Instument 5 |** Mot Selected == ﬂ

| Back | | Wiew Techrical File |

Use the drop down boxes for the Uncertainty Statements if using this method of
uncertainties for the certificate. Note there are a maximum of 10 lines of statements that
can be printed on a certificate using this method.

LEAVE ALL STATEMENT LINES SET TO “*NOT SELECTED** IF YOU WANT TO PRINT INDIVADUAL
UNCERTANTIES WITH EACH TEST AS REQUIRED FOR AN ISO 25 /17025 ACCREDITED CERTIFICATE

Use the drop down boxes for any reference standards used in the procedure. Not that
ProCal automatically knows about reference standards used when manually selected in
tests, or are the default instrument for that test. Other standards used as ancillary
equipment, for example a thermometer to measure the temperature of a resistor will need
to be added here.

Instrument 9 ‘Reserved For Unit Under Test (UUT)’ must be clicked. Enable if the UUT’s interface is
being used to perform a closed loop calibration. This will cause ProCal to Prompt for the UUT’s
interface either as a GPIB (IEEE488) address or as serial COM port number before starting calibration.

Test Control

When editing a procedure or creating a new procedure the buttons below the data screen
enable the user to control the process:

g [v ituto Units
Back Show All| Undo Delete Insert Copy |4l Previous Mext Done
Test Mumber 1 ze the 'C' button Cright) to check the test seftings for errors ===
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<Back:
Returns the user to the previous screen— Procedure instrument information screen

Show All
Displays a list of all the tests in the procedure

Test List
Ma. Test Title Test Value Accuracy Uncertainty
B TITLE LR i =
2 1V I.Z. Range o0.9900v 3.1
3 10V D.C. Range o.900v 27 . BmV
q 100V I.Z. Range oo, 00V 277 . 5V
) 1000V D.C. Range 1000, ov 4,3V
B e BELANE LINE--———————————————— — ——— ———————
7 TITLE LINE : AC Woltage
] 10V A.C. @ S0H= o.900v 156. 5wV
9 100V &A.C. @ S0DH= oo, 00V 1.6V
10 70V A.C. [ S0H= 7E0.0V 12,1V
11 ——————— BELANE LINE--———————————————— — —— — ——— ————
12 TITLE LINE : DC Current
13 10md D.C. Bange 9. 900rma S2.2uld
14 q0mwi D.C. Bange 39, 00rmi 372 .5ud
1%t 10 D.C. Rahge 10.0004 S3md
1 ——————— BELANE LINE--———————————————— — —— — ——— ————
17 TITLE LINE : AC Current
12 10mi L.C. @ S0H= 9. 900rma 181.2ud
19 40mb AL.C. @ S0H= 39, 00rmi Te2.5ud
Erint Procedure Cancel 0k,

From this screen it is possible to jump to any test simply by double clicking on it or clicking
‘OK’ after highlighting the relevant line.

A short print out of the procedure can also be generated from here by clicking on ‘Print
Procedure’.

Undo
Undoes all changes since moving to that test.

Delete

Removes a test from a procedure. All other tests are shifted up one line. Any formula
functions, which use a test number, are also adjusted.

Insert

Inserts a blank test above the current tests in the procedure, all tests below are shifted
down one line. Any formula functions, which use a test number, are also adjusted.
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Paste and Copy

Pastes a complete test, which was previously copied using ‘copy’ over the current test. If
the ‘Paste’ button is greyed out then there is nothing in the buffer to paste, copy a test first.

Note: Paste does not insert a test, it will Paste over any existing data, use ‘Insert’ first to create a new
blank test if required.

Previous

Click to step back a test. — Note you can also double click on the test in the test window.

Next/ Add New Test

Move down a test, if already on the last test, a new test will be automatically created. Note
if you create a new test by mistake use delete.

ProEdit Test Types

[ Test | | | | -
Test Tupe | j

Meter
Meazurement
General

Pasz / Fail
Certificate Format

Continuity / Insulation Tester
PAT b’

[w Auto Unitz

Eﬂﬂk Show All| Undo | Delete Insert Copy _"1"“ Previous &dd Hew Done -
(i

Test Humber 1 =g the "' button Cright) to check the test seftings for errors ===

Much of the power of ProCal is the speed and simplicity in which a Procedure can be
written; this is due to the ease in which tests can be created.

In ProEdit the first action in creating a new test is simply to decide what type of instrument
or test is needed. From this first selection ProEdit can restrict the information displayed and
the format to only the data required for that test type.

When an oscilloscope, meter or measurement type test is selected, ProCal will also know
what instrument to use, such as a calibrator or DMM (Digital Multi Meter). As ProCal
already knows how to communicate with the default instruments via its inbuilt driver there is
no need for any ‘interface code’ to be embedded in a test. All that is required is to set the
values required and ProCal will do the rest.

This very powerful feature allows a ProCal procedure to be used on different calibrator’'s
without modification as the driver imbedded within ProCal is handling the interface code.
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As there is no need for most tests to get bogged down in writing interface code, control
code tests can be generated very quickly.

Description of Test types

Oscilloscope

For calibrating oscilloscopes using the system oscilloscope calibrator, selected in Line 3 of
the traceable instruments table in ProSet
Used for Amplitude, time base, rise time and bandwidth tests.

Meter

Use for calibrating any kind of meter using the system Multi product calibrator, selected in
Line 1 of the traceable instruments table in ProSet

Measurement

Use for calibrating any instrument you need to measure the output, using the systems multi
meter (DMM), as selected in line 2 of the traceable instruments table in ProSet.

General

This test is very powerful as it can be used for almost any type of calibration where there is
a test/applied value and a result.

For example it could be used for calibrating a pressure gauge using a dead weight tester, or liquid in a

glass thermometer with a liquid bath. It does not need to be electrical measurement and does not have

to control any instruments at all. Although electrical tests can be performed using this and instruments
can still be controlled from the command window.
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ProEdit

Test Title Test Value Incertainties

Aocuracy

Preszure Rising S0Bar S00mBar 0.05B8ar
500mBar 0.08Bar
SO0mBar 0.05Bar

Pressure Rising

Pressure Rising

Test | Promptz | [nztruments | Advanced | Print |
Test Type |Eeneral ﬂ
Test Title |F|ESSU[E Hising Frequency [Hz] EE_‘-: “Aalue |2 - |
h0B —
Test Walue | ar j Syrmbols Readna DF. [1 o
Inst. Range |5I]Bar j [Opticnal] | :l
RESULT INPUT
% Of Reading % Of Range ZeroiTatal Accuracy Counts (= Kevboard |
-
Acouracy [+) | o |1 54 | + | — |5I]I]mBar wboard (manual)

{ Keyboard (deviate)
Accuracy [[]  Enter accuracy [including unitz], ar leave blank, ta use Accuracy [+] |

Uncertainties |0.08B ar

g v Auto Linit
ﬂﬂ'ﬁk Show All| Undo Qelete Copy :‘1" Previous Hext Dunel_ 0 Unitz

Test Mumber 32 Set the te=t data required

Any units can be used in this test, PSI, kgs, millimetres, inches etc.
This General test type makes ProCal a completely universal calibration software package.

Pass / Fail

For tests where there is no numerical result, a simple Pass/Fail result can be chosen, for
example a continuity bleeper.

Certificate Format

Used to format the certificate, although ProCal does not run a format test; they are passed
through to the certificate. Allows page breaks, titles, and blank lines to be added to a
certificate.

Continuity / Insulation testers

Tests specifically for calibrating insulation and continuity tester using the Transmille 2100.
Covers high value resistance to 10 GOhms, Low value resistance and Insulation test
voltage measurement.

PAT

Tests designed to cover the calibration requirements for PAT testers using the Transmille
2100. Tests include earth bond resistance & current, insulation resistance, leakage current,
flash voltage measurement etc.
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RCD Testers

A specific test that only works with the Transmille 2100 to calibrate both RCD current and
time.

Loop Testers

For calibration of loop tester using only the 2100. Allows selection of loop values with
read-back from 2100 of loop value after correction for local loop supply.

Pressure

Tests for calibration Pressure indicators, sources and switches using the Druck DPI1515
calibrator.

Oscilloscope Test.

Select this test type for calibrating an oscilloscope’s amplitude, time base, bandwidth & fast
rise. See pass/fail test and general tests and meter tests, which may also be used in an
oscilloscope procedure

This type of test will use the oscilloscope calibrator selected in
ProSet>file>instrument traceability: Line/Instrument 3

Select the Test Tab and test type then enter ‘oscilloscope’
The functions that can then be selected are

[ Test | | | | | -

Test Type |I]s-::illust:upe j T ezt Function | j

Amplitude

Timebasze

Rize Time

Bandwidth [Levelled Sweep]
B andwidth [Fast Rize]

Select the required option and fill in the test data as required. Most fields are obvious.

Note: To use deviate the calibrator for amplitude and time base so the trace can be aligned
with the graticule.

To create an Oscilloscope procedure it is recommended to first use the wizard in ProEdit
and then edit the procedure.

Further options, setting and controls

Many more functions, controlling the UUT, formula, etc are available in the other tabs;
these functions are covered in the section following ‘test types’ on Page 79.
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Meter Test (Use calibrator to calibrate meter)

One of the most used test types for calibrating all types of meter.

: Digital or analogue multi meter measuring volts, current and resistance etc.
: RLC meter

: Frequency meter

: Temperature meter

: Pressure meter

RPM meter (for 2000 Series calibrators only)

: Torque meter

: Power meter

[ Test | | | | | -

Test Type |Heter ﬂ TestFunctiDn| j

D.C. Yoltage A
D.C. Current

A LC. Yoltage

A_C. Current

Resistance

Capacitance

Inductance

Mark/5pace Ratio v

O~NOUOAWN

After selecting this test type then select the test function and next select the measurement
parameter of the meter.

Editing a Procedure

ProEdii Currently Editing : (Procedure : B3)

Test Title Test Walue Accuracy Uncertainties
DC Yoltage
1% D, Range 02900y 3.1my
10V D.C. Range 9.900VW 21.8mV
100% 0.C. Range 99 00% 2ET AmY
1000% 0. Range 1000.0% 4.3y
Test | Prompts | Instlumentsl Advanced | Frint |
Test Tupe |Meler j Test Function |D_E_ Yoltage j
i 1WDC. R Test “alue
Test Title | ange 0P 1 -
9.900v¥ T —
Test Walue | Symbaols Reating D.F. lj
Inst. Range |10 - [Optional]
. RESULT IMPUT
% 0f Reading % Of Range ZarwTotal Aocuracy Counts & Keyboard § D
'&‘ - . = ,7 - who3 manu3l
couracy [+ (026 4| z+| +|3 8V board (deviate)
Urcertainties | {~ Devigte Calibrator
» v Auto Units
EaCk Show All Undo Delete Insert Copy | [l Previous Next Done
Test Humber 3 Set the test data recuired
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Test Title
This is the Printed title on the certificate, it has no control function and is just text.
If performing an AC test the frequency should be in the title.

Test Value

This is the value that the calibrator will be set too. The units must correspond to the
function selected, e.g. mV or V for a voltage tests.

Note: The value in this box will be used in the accuracy calculation as the % of reading

Instrument Range:

This box can be left empty if there is no % of range accuracy, otherwise enter the full scale
of range.

Accuracy Boxes
ProCal will calculate the total instrument error by adding together the contributions by

% Of reading
This is used to calculate the error of reading from the value in the Test value box above.

% Of range
This is used to calculate the error of range from the value in the instrument range box
above.

Zero/Total accuracy
This must be entered in the same units as Test value and is used directly

Counts

Many DMM specifications quote a floor error as a number of digits or counts. The number
entered here is used together with the resolution of the last digit taken from the decimal
point (D.P. boxes) above. From this ProEdit can work out the error in the units of the test
value.

These boxes are added together dynamically and the error can be seen to change as data is entered.

The 4 boxes have been provided to allow for the way different specifications are written, if there is no
specification for one or more boxes leave blank. It is only necessary for ProCal to have one box with

data in.

Test Value D.P (Decimal Points)

This is the number of decimal places the applied value will be printed onto the certificate.
Usually set to be one more than the reading.
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Reading D.P. (Decimal Points)

This is the number of decimal places used to print the DMM reading to. If left blank it will
default to the test value above. This is also used as part of the uncertainty calculation and
accuracy calculation above.

Result Input

Keyboard (Manual);
Enter reading from DMM using keyboard.

Keyboard (Deviate):
Nominal test value is displayed, which may be incremented or decremented by using
keyboard. Useful for a frequency counter with long display lengths.

Deviate Calibrator:

Use mouse/keyboard to slew calibrator until meter reads correct. Very useful for older
analogue meters.

Uncertainties

When uncertainties have been calculated manually enter the value here, this value will be
used by ProCal in the test and passed on to the certificate when this test is run. The auto
uncertainty calculations function is disabled when a value is entered in this box.

Auto Units

The auto unit’s option allows units to be preserved as entered. When clicked ProCal will
convert values to the most appropriate scaling (e.g. 0.05V would convert to 50mV).

Additional Information (Resistance, Temperature & Power Test Functions)

The resistance test function also has an additional 4-Wire selection checkbox

| Test | Prompts | Instruments| Advanced | Print | -

Test Type |Heter ﬂ Test Function |Hesistan-::e j M <l

The temperature test function also requires the thermocouple type to be selected. This is
displayed in a drop down list.
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Test

| Prompts | Instrument$| Advanced |

Frirt |

Test Tupe | Meter

ﬂ Test Function | Temperature

[

TestTile  [100°C Tstibe  [7 o]
Testalue |1I]l]'E j Surnbols Remding D.F
Inst. Range | j E;rem:-cnuple TYPE w | [Optional] :|‘r
. RESULT INPUT
& Of Reading & Of Range ZerofTotal Accuracy

Aecuracy [+] |5

z4 |

IIncertainties |

4

+|

{(* Kayboard (manual)
(" Keyboard (deviate]
(" Dewiata Calibratar

The power test function also requires the voltage and phase angle to be set.

| Note: The current is automatically calculated based on the Voltage, Phase Angle and Test Value. ‘

| Test

| Pramptz | Instruments| Advanced |

Print |

Test Type | Meter

j Test Funchion |F"uwer [wattz]

Test Title |1 kwf Frequency [H 2] (M1} -EIE_':‘I ‘walue m
Testalue  |TkWw - Yaltage 200¥ - _ _

| = 7ona e | =~ Readng 0. [~ |
Irist. Fange | ﬂ ) 8 |45 - | [Optional]

% 0f Reading % 0Of Range ZeroiTatal Socuracy Courts RESULT INFLT

Bl

Accuracy [+ |1 1]

z4 |

Incertainties |

4

+| +| = 100w

{* Keyboard imanuall
(" Kayboard (deviate]

Tab Function’s in the test data screen in ProEdit

Each test in a ProCal procedure has five ‘tabs’ the first tab selects the prime test function,
covered in the previous section on Page 74.

The other tab functions perform basically the same for all test types:

Tabs in the ProEdit test data screen

| Test | Pramptz | Instruments| Advanced | Print

Prompt tab
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Test | Promptz Instruments| .-’-'-.dvanu:ed| Print

Test Type | General ﬂ

Show Help Screen Befare Test (= ‘ez (" Mo

Before Test Prompt File | Link to > Image / Video Text File Wieww Folder
Before Test Prompt Text |Selet:t DCY Range and connect Test Leads
Calibration Test Prompt File | Link to > Image / Video Text File Wiew Folder
Calibration Prompt Test |Adiust for Comrect Reading using YR 2
g v Auto Lni
Back| Show All| Undo | Delete Inzert Copy Ereviuus Done 5 Ll

Test Humber 1 Erter prompts £ select picture or text filenames C

1:Show Help Screen Before Test:

Sets ProCal to display a help screen before starting the test. This is to allow the operator to
set up the instrument and connection from the on screen information before the test is
started. To run the test directly without displaying help click ‘No’

2:Before Test Prompt File:

The name of either a text (.txt), Graphic (.BMP) or video (.AVI) file which will be displayed
before the test starts (as above) or when selected with the ‘help’ button on the ProCal
measurement screen. The “..." button & the ‘Edit’ button are to help select and edit these
files.

The files may be created using any program that will produce the required file extension
format

Note: Windows Media Player is used to play video files.

3:Before Test Prompt Text:

One line (40 Characters), which can be typed in here and displayed instead of using the file
above. Useful for short instructions for that stage of the procedure.

4:Calibration Test Prompt file:

Same as 2:(Before Test Prompt File) but only shown when selected from ‘cal help’
(Calibration Help), button on the ProCal measurement screen. This is to give the operator
instructions on how to adjust the instrument. — Note the “Technical help file’ is very useful
for this as well. The ‘...” button & the ‘Edit’ button are to help select and edit these files.
The files may be created using any program, which will produce the required file extension
format.
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Note: Windows Media Player is used to play video files.

5: Calibration Prompt text:

Same as 3:(Before Test Prompt Text) but can only be displayed when the option is
selected via the ‘Cal help’ button.

ProCal User Manual V4.00 Page 84



Procal Calibration Software: User Manual

The Instruments Tab

| Test | Promptz | Instruments| Advanced | Print |
Test Tvpe IEenemI j
Ref. D EEfELI't i, Precision hulti- Product Calibrato L rt U rt.
st Pk . Precizion hulti-Product Calibratorgied T:rzepl. ll LiT'uZE ll
‘&3_7 01 :L: 204 A Precision hiulti- Produc o 7
re-Test Commar] re e e o gt _I Post-Test Commands [GRIB] £ [R5232] _I

L : 2100 Bectrical Test Calibrato
L:™ MOME™"

06 : L:* NOWE™
L
L

;7 MOME ™ - -
: 8000 Decade Box s i b

LI 08 :
%5 Click here for help on entering instrument commands Hide Command 'Windows |
. W' Auto Unit
= Back | Show All | Urnda | Delete | Inzert | Fazte | Copy | ﬁErewuus &ﬂew Test =2
| T est Mumber 1 | Entet data for IEEERS232 controlled instrumerts Q
ef Inst
Ref Inst:

The Default option is usually selected which sets ProCal up to automatically use a
reference instrument from the ten instruments listed in the Instrument Traceability List.
ProCal will for example automatically select the DMM at position two if it is a measurement
test, or the calibrator at position one if it is a meter type test.

For a general test it is necessary to select a Custom Reference Instrument, selecting
Custom will preset a list of instruments in the drop down list to the right, this list will display
all of the instruments in the Instruments Traceability List. (As set in
ProSet>File>Instruments.) Select the required instrument.

Note: When a custom standard is selected, the value set in the Traceable instrument table will be used
as the Nominal test value.

Uncert Temp (Uncertainty Template):

Selects the uncertainty template required to perform the uncertainty calculation for this test,
as created in ProSet. This template will be called and used by ProCal at the time of
measurement.

Uncert Line (Uncertainty Line):

If the reference standard used for this measurement has different bands of accuracy as set
in the ‘uncertainty file’ in ProSet then the correct band can be selected here.
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Post-Test Commands:

Type in here commands to be sent to instruments using either the GPIB interface or the
RS232 serial COM’s port.

Click on the ‘?’ to show a list of available commands. Double click on the window to
enlarge it.

There are three ways to select the address the instrument is to commutate with.
The address must be at the start of the line and immediately before the command

Communicate with any instrument by directly using its address or COM port

For GPIB start the line with the GPIB address of that instrument:
Example: 14 SETACV: Will send ‘SETACV’ to instrument with GPIB address
14

For RS232 serial start the line with COMxx, where xx is the COM port number.
Example: COM2 SETDCI: will send SETDCI to COM port 2

Set Baud Rate, Parity etc. for serial Commutations.

See example in the command window below.

COM2 CONF-VOLT:DC 1 COM[1200.M.8.1] ;I
COMZ2 CONF:OUTPUT ON COM[1200.N.8.1]

e i

The COM command is comprised of the following parameters:

COM [Baud Rate, Parity, Data Bits, Stop Bits]

Baud Rate: The following table lists the valid baud rates.

Setting

110

300

600

1200

2400

9600 (Default)
14400

19200

Parity: The following table describes the valid parity values.

Setting Description

E Even

M Mark

N (Default) None
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0 Odd
S Space

Data Bit: The following table lists the valid data bit values.

Setting

@ |N[o (o>

(Default)

Stop Bit: The following table lists the valid stop bit values.

Setting
1 (Default)
1.5
2

Notes on use:

UUT FUNC: DC 1 COM[1200,N, 8, 1]
UUT FUNC: AC 10 COM[1200,N, 8, 1]

The COM command MUST be placed at the END of each command line

The default COM settings are 9600,n, 8, 1 - these will be used if no COM command is
present

To Communicate with an instrument in the Instrument Traceability List

Use ‘@’ followed by the line number in the list. ProCal will then take the GPIB address
entered for that instrument in the instrument data set by ProSet.

The advantage of using relative addressing is that should an address of a reference
instrument be changed the procedure can remain the same, the only change is to update
data in ProSet.

Example: @02 SETACV :will send the command ‘SETACV’ to the instrument in the 2
position in the traceability list, e.g. the system DMM.

To Commutate with the instrument under test (UUT)

If a procedure is set to communicate with the UUT by selecting on the Procedure
Instrument information screen when creating/editing a procedure, then when ProCal runs
this procedure a message box will prompt the user for an address of the UUT.

To use this address in the command window start the line with UUT, commands will then
be sent to the address entered by the operator in the address message box.
This allows an instrument to be calibrated using it address as set, avoiding changing it.

Example: UUT DCV 1V: Will send ‘DCV 1V’ to the address of UUT.
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Terminators:

All commands will be sent as entered, to add a carriage return or line feed the append
>CR to add carriage return
>LF to add line feed
>CR>LF to add carriage return and line feed.

For GPIB commands the EOI line will be asserted with the last byte sent.

Other Commands:

Delays:

Use to allow a setting delay between two command lines
Example Delay 1.5: Gives a 1.5 second delay.

Reading a measurement back from a GPIB instrument

Set addressed instrument to talker and place data into string variable ‘READING’ until EOI
or line feed received. Return instrument back to talker. Timeout of 30 seconds.
This command simply reads directly, from the instruments, it usually necessary to first send
a range and trigger/take reading commands. Note this command does not use the GPIB
‘SRQ’.

Example: UUT FETCHREAD : Get reading from the UUT

or @02 FETCHREAD : Get reading from instrument 2 in
the traceability list.

Note these commands are only meaningful in a General or Meter test type.

Formatting the string variable ‘Reading’

The data sent by the instrument to ProCal is stored in the string variable ‘reading’. This will
contain other characters sent by the GPIB instrument, which will need to be removed
before being changed into a numeric value, which can be used by ProCal.

Example TRIM 3, 4 : this will remove the 3 leading and the 4 trailing characters.

It may be useful if unsure of the string sent by the instrument to first check using a simple
GPIB program first, for example the GPIB test programs supplied with the NI card.

Setting the Nominal or measured test values to the reading taken with FetchRead.

The readings taken and placed in the variable read, once formatted by the “Trim’ command
above, can be stored as either the nominal test value or the test value itself used in the
ProCal measurement screen.

ProCal User Manual V4.00 Page 88



Procal Calibration Software: User Manual

Example MEAS=READ
NOM = READ

With these few simple commands it is possible to set a DMM range, trigger a reading and
store it to the nominal test value, and then set and read from another DMM and store it as

the test value.

Post Test Commands

Type in here the commands to be sent to instruments after the test is finished using either
the GPIB interface or the RS232 serial COM’s port. This is to reset instruments back to a
safe state.

Example use of command Window

Sending extra commands to the System DMM in a measurement test and setting a
calibrator:

Fef. (@ Defautt Unicert ll Uncert. Ll

Inst (") Customn Ternpl . Lire
Pre-Test Commands [GPIB] / [R5232] Post-Test Commands [GRIB] / [R5232]
@02 NPLC=100] +||uuTt s1>cR =

@02 LFILTER OM
uuT R1/0100.5/50:CH

r N o

¥ Click here for help on entering instrument commands Hide Command ‘Windows |

= Ommls | [ PR R I HIEEST I { g B I Lo | et | R | & (e | .] h.l_...T_.I.lp MD Unitg

The DMM is the HP 3458A,; the UUT is a Transmille 2000 series calibrator

Line 1: Sends the command NPLC=100 to the DMM to set reading rate

Line 2: Sends the command LFILTER ON to the DMM to set filter

Line 3: Sends the command R1/0100.5/S0 to the calibrator with a carriage return character

as a terminator.

Note ProCal gets the COM port to which the calibrator is connected from the message box
displayed at the start of the calibration.

Note: This function must be selected in the Procedure by clicking instrument 9 in the calibration
information screen.

Example Reading from the UUT
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Ref. @ Default Urizert w | Uncert. =
Inst (" Customn Termpl . —I Lire —I
Fre-Test Commandz [GPIB] # [F5232] Post-Test Commands [GRIB] £ [R5232]

UUT READ? «|luuT 51:CR -
UUT FETCHREAD _I _I
TRIM 3.5

MEAS=READ

] _'*I_I ! _»I_I
%5 Click here for help on entering instrument commands Hide Command ‘Windows |

Line 1: Send command READ? To the UUT to trigger a reading

Line 2: Get the reading from the UUT. The FETCHREAD command tells ProCal to set the
addressed instrument to talk and then read in up to either EOI or Line feed. This data
transfer is not using service requests.

Line 3: Trim off unwanted characters

Line 4: Set measurement to the value of the reading back from UUT.

Note: Click on ‘Click here’ for a list of commands and examples.

The Advanced Tab

| Test | Promptz Instruments| Advanced Print I

Test Tvpe I General j

Farmula || 9 Mumber of Coil Turne I

Autoztep ¢ OFF ¢ OM Samples Eefore Autostep I

External UUT Caontral Program |
External UUT Adjustrent Program | % Spec. I

Formula Box
Use this box to enter a formula to process or scale the reading.

» - Example 1: Taking off zero / end resistance from readings
If you needed to take lead resistance value off another measurement, simply
create a test which measures this lead resistance (e.g. test 1), then in subsequent
tests (e.g. tests 2 and above) use the formula to subtract the lead resistance value (result
of test 1) from the measurements e.g. X-T1 (where X is the current test value and T1 is the
reading taken in test 1 — the end resistance).
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When using a 2000 Series calibrator in two-wire ohms mode, the zero value can be used to
measure the resistance of the leads without needing to manually short the leads together.

Create a two wire ohms meter test using the zero ohms output from the calibrator and use
the formula X-Z (where X is the meter reading and Z is the calibrator zero ohm value).
When the meter reading is subtracted from the calibrator zero ohm value this gives the
actual lead resistance. This lead resistance value can then be used in subsequent tests by
subtracting this value from the test value e.g. X-T1.

i Example 2: Scaling the output from a transducer

w) If you are reading the output of a 20Bar pressure transducer (which gives 10V
output for 20Bar pressure) with a DMM using a measurement test and you want the
measurement to be in Bar, use a formula to SCALE the reading e.g. X*2 (where X is the
voltage being read back by the DMM and 2 is the scale factor).

Note: This test would also use the DUAL UNITS function which allows a DMM range to be set to
VOLTAGE but the test value to be set as BAR.

i Example 3: Changing the nominal test value

\) If you want to perform a test where the nominal value is not known until
measured, first create a test, which measures this required value (e.g. mains voltage).
Then in each subsequent test which requires this value as its nominal, set the formula
N=Tx (where N is the nominal value for this test and is being set to the value taken from
that test x).

Formula Help I
E/'i‘ Formula Key
#  :LCurent Test

Tux : Testux
Z  :2Zero Ohms (from 2000 Series calibrator)
M= : SetMaminal ta [T=x]

Exx : External raceable walue [az zet in ProSet traceability list]

Walid Operators ;

+-4%

Examples

#-Ta34 : Subtract test 34 from current test

KL : Subtract calibratar zero from curent best
#E075 . Multiply current test by 075

M=T1 : Set nominal ko the result of Test 1

M=T142 : Set naminal ta the rezult of Test 1 divided by 2

#=/E18  : Divide reading by value stored in raceability location 15

M=T10/E15 : Set nominal to walue of test 10 divided by value ztored in
traceability location 15

Note the ability to use the value for a reference standard in a formula, this can be useful in
many cases for example using a current shunts for measuring high current, where the test
type would be a measurement of DC voltage which would require the measurement to be
divided by the certified value for the shunt to convert to amps.
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For example X/E23 would divide the voltage read by the DMM by the value of the current
shunt E23. The value of the standard must be entered in the instrument traceability table
by ProSet first. The value of the shunt may of course be used directly in the formula, but
by using this method only the value held in ProSet, need be changed when the standard is
recalibrated.

Farmula [x7E23 (7]

The formula field does not recognise brackets, the expression is evaluated only from left to
right.

Dual Units

Clicking the DUAL UNITS checkbox allows the test value units to be set to a different type
than the DMM range units (e.g. 10Bar for test units and 10V for DMM range).

Note: Normally the test value and DMM range must be the same otherwise ProEdit will indicate a test
error due to the different units being detected. Dual units permit different units.

This is particularly useful when reading back from transducers where a voltage or current is
read back from a DMM but the signal is pressure, torque etc.

See ‘example 1’ of the formula function for more information

Number of turns:

This box is for the number of turns of a clamp coil adaptor. The current entered in the test
value box for a meter type test is divided by the ‘number of turns’ before being sent to the
calibrator.

This then sets the calibrator to output the correct current when using a coil. The numbers of
turns when using a Transmille Clamp Coil range from 5 to 10 to 50.

Auto step:

This selects if the test will automatically step on. If clicked ‘yes’ a drop down box can set a
further condition, such as the length of time before the current test is stopped and the new
one begun.

ftostep © OFF & 0w -

External UUT Control Program I ?l]

Esternal UUT Adjustrment Program I—Eﬂ [——=
-

Back | Shaw Al | Undo | Delete | Insent | is0 M 14

szt Murmher 1 | Select ;Ea?'lced ontions E
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From this box the action can be conditional on the result of the test. Select ‘Y’ to allow the
test to step on regardless of the result, or select the percent of specification to pass the test
by before stepping onto the next test.

Note that selecting auto step changes the control menu in ProCal. Auto step can be over

ridden via the ‘Control’ menu at run time allowing a procedure to be single stepped in the
usual way, which is very useful for testing.

Samples Before Auto step:

This controls the number of samples or readings that are taken before stepping on to the
next test. If left blank three readings are taken on a measurement test.

External UUT control Program

To perform advanced control and calculation functions outside of the scope of ProCal. By
entering the file name of this external program in this box ProCal will automatically create
and save test information to a file, and then execute an external program. With ProCal in
suspension the external program can then open this file and perform whatever task it is
written to do. On closing this program it will pass data in a file back and restart ProCal.
This feature allows ProCal to be used for any calibration task. The external program can be
written in any language, visual basic, C, etc the user is familiar with. As the external
program only has to perform control and measurement it can be relatively small, leaving
ProCal to do all the major work. This approach can dramatically speed up the development
of semi custom applications.

See Appendix for application notes on writing external programs.

External UUT adjustment Program

As above but this program will be written to make software adjustments to the UUT and will
only be called under the following conditions.

1: ProCal will be running after adjustment tests

2: Run Adjustments tests in the ProCal control menu is selected

3: The % of spec error is larger than the figure entered in the ‘% spec’ box.

The Print Tab
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| Test | Frompts | Instuments | Advanced | Frint I
Test Tupe IEeneraI j
Print Type I.A.Iways Pnnt Test j

Alwavs Print Test
Print Only If Failed
Do Hot Print Test
Print Only If Completed

Always Print Test:

Most used option; the result of the test will always be printed on the certificate.

Print Only if Failed:

Used mainly for ATE (automatic test equipment) stations where only failed results are of
interest.

Do not Print test:

Use for test to confirm operation or pre-tests, which may not form part of the calibration.
Also allows for ‘lead connections error checks’ to be performed, for example before a 20
Amp test perform a 2.1A test to check that the leads are in the correct sockets on the DMM
before applying the full current with incorrect connections and blowing up the DMM.

Print Only if Completed:

This print type allows one procedure to cover an instruments model, which have different
option combinations, fitted.

When ProCal starts to run a test with this set it will prompt the user if they whish to run this
section. ProCal takes the title test before as the name of this section of tests. If the user
answer yes the tests are run, if no then the block of tests with print only if completed is
jumped over.

For example a DMM may come as standard with only DC volts, with options for AC volts,
current and resistance. Normally this would require several procedures to be able to cover
every combination. By using the print only if completed test, only one procedure is
required.
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Certificate Printing using ProCert

ProCert is the certificate-printing program and is installed as part of the program suite of
ProCal.

Using this program certificates can be searched for and reprinted. This program can be
used on, as many PC’s as required to print certificates locally from a central ProCal
database.

Certificates can also be printed at the end of a calibration or from ProCal track.

Certificate Types & Styles
For flexibility ProCal offers a choice of two methods used for certificates & report styles

1: In built report styles (including a standard certificate and an accredited ISO17025
certificate) built into the program. These offer ease of use but cannot be edited by the user.

2: Crystal reports custom styles. There are several example reports (including a standard
certificate and a accredited ISO17025 certificate), which are installed with ProCal and can
be used as templates for the user to edit and create their own custom reports.

Crystal Reports allow the user complete flexibility in the design of the reports. A report is a
mixture of data fields, which take information from the database and text. Once created
this report can be given a file name and saved. Reports for all sorts of purposes can be
written, as can been seen from the installed examples including instrument fault reports,
Quotes, Reverse traceability etc.

To edit or create a crystal report the ‘Crystal report’ program must be installed. Once
created a report can be used without installing Crystal reports on other workstations.

When this report is selected the data fields will be filled up and the complete report is
displayed on screen, this can be then printed, emailed, faxed etc as per normal.

ProCert will use the type of report stored in the certificate data.
This can be either the built in standard certificate report, or the accredited style certificate
or use the file name of certificate reports written by the user in Crystal Reports.

Note: ProCal will save the file name of a crystal report for ProCert to use. This file name will be copied
from the procedure, or if not set in the procedure will use the ‘Global’ name set in ProSet>Program
options. If this field is empty then the built in certificate format for that certificate type,
standard/accredited/test report etc will be used.
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ProCert Menus

File menu: Search for certificates

F: Search for certificate(s) El

Tip : Select criteria to search by clicking on one or more button(s).
To view all certificates, click start search without selecting a search criteria.

By Cert Humber >
By Calibration Date >
By Model Humber >
By Serial Humber >

By Customer Hame >

[ Accredited
[*x Standard
7y Select Accredited,
Standard or both.

Start Search

Cloze

Click on the ‘Search by’ buttons to open up a search box. Enter the details to search by,
use *’ as a wildcard. Use more than one search button if required, then click the search
button to start the search.

Note: that just clicking on ‘search’ will show all the certificates.
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Search Results

@ Certificate List [Multi-Search]

Swyztern D Certificate Mo, [u] = UEAS Cal Date M odel Mumber Senal Number
IDOA0T: STD=05 02022009 sl 5958819
IDoalm STDSR4E 010272009 TD 495 E1035F
ID205% 4293R40 0101 /2009 TL304 2971305
IS5 4102020 1201272008 TL309 L3MED
IDE5en 4193820 10s12/2008 34014 LD3240
D295 4019520 0551272008 20=0 419058
IDG4E50 STDA4E S0s1172008 TL3028 1025410
T2 4394205 250572008 3259290 D402

Cloge Search | | Print

From this screen select the certificate to print.

Print Dialogue Box

. Print Certificate(s)

s

Mumber of Copies

1
2

3

Mare

Print Dptions

[® Print Calibration Certificates)

i:lf Print cover sheet

[® Frint results sheet(z]

i:lf Az Found
]

Drefault Printer for Certificates

|HF' Lazerlet 1200 Series PCL

Bl

[ Print Certificate of Conformance(s)]

¥ Print Labells] [ Print Cal

| Advanced Settings

Statuz

Due? |

Select the required options for printing, select the printer and click OK to print certificate.

Note a PDF printer can be installed on windows to enable a PDF certificate to be produced.

Options Menu
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Certificate Cover Company Logo
Certificate LKAS Logo

Zonfi Label Print
origures LabetFrinter Certificate of Conformance Logo

Edit Certificate of Conformance Texk

Edit Certificate Fooker Text

Set Logo Positions

This allows the logo print position to be set for the inbuilt reports. Depending on the logo
size and printer resolution this will need to be set by trial and error. Note this positions two
different logos, the company logo used on the standard certificate and the
ACCREDITED/accreditation logo.

Adjust pozitioning for the
prirted logo

¥ = Across
Y = Do

¥ Position
' Position :

| LCancel | | (1] 4 |

Configure Label Printer: Configures Seiko type label printer.
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Eﬂ Configure Label Printer

f* Standard Serial Printer [ASCI Qutput) Print Test
¢ DiYMO 300 Series Printer  Label
i Seiko Smart Label Printer® [Label Code : SLP-TMAL]

Port

fv COK1

" COM2

" COM3

" COM4
" U5B

Edit Certificate of Conformance

Clicking Options->Edit Certificate of Conformance Text will open a Notepad file, which can
hold customised information for the certificate.
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Appendix

Data Paths
The below paths are automatically set upon installation of the software

Certificates Database
C:\PROCAL\CERTIFICATES

Enter the path to the certificates database. Click the “...” button to bring up a file window
and navigate to the location of the database. The database file name will be
ProResDB.mdb and is shared with the ProCal programs. This is where all certificate data
will be stored, the data path should not be changed unless linking paths and files are also
updated.

Contacts Database

C:\PROCAL\CERTIFICATES\CONTACTS.MDB

Enter the file name of the contacts database. Click the “...” button to bring up a file window
and navigate to the location of the database.

Digital Photos

C:\PROCAL\INSTRUMENTPHOTOS

Enter the path containing digital photographs of the instruments. Click the “...” button to
bring up a file window and navigate to the location of this directory. The digital photographs
directory contains a number of bitmap files with the same name as the instrument they
illustrate.

Sales Database

C:\PROSALES

Enter the location of the sales database. Click the “...” button to bring up a file window and
navigate to the location of the database.

Stock Database
Enter the location of the stock database. Click the “...” button to bring up a file window and
navigate to the location of the database.

PDF Scans
C:\SCANTEMP

Enter the location where scanned documents will be stored. Click the “...” button to bring up a file
window and navigate to the location of the .PDF files

Advanced Edit

Advanced Edit can be found on all virtual job sheets, to manoeuvre to this menu, click File-
>View/Edit an Instrument, enter the identifying number such as an instruments serial or job
number, when the instrument details appear, double click them, or highlight them and click
View/Edit.
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Virtual Job Sheet

Jab Infa l Inst Detailz | Cent Address | Returned By | Despatch .ﬁ.ddress] .-'-‘-.n::c:essn:nries] Service Details] Histn:nr_l,l]

Job Mumber : Lirik. Service Details l S ub Contract Details] Do Mot Recall [
[Date Recerved E%F
&M Service Type : | j
Order Mumber : View Cert, Tope - | j
[rvoice Murmber ; Docs
Cuote Status | j
Despatch Date Add

Calibration Date Scan| |QuoteNo.:

Calibration Due Mat Availlable Link, Service By : | j E|
Certificate No. - PEDEE Warnanty [ Mainz Safetp [ FastT/R [

Status : | j Turn-around : | vl Dayps Cal Interval : - | Weeks

lse - | Customer
| J Comments --»
Boaoked
E B j In=t. Log
| Cloze || Erint Menu |

Once this menu appears, click on Advanced Edit to change more intricate details about
the instrument, such as the signatory for the certificate, or the traceable instruments used
during its calibration.

* _ Edit Calibration Information For Instrument

Dezcription Drata

Cal Ref E
Inst_ID :
Cert_No

Cust_Rerf

Cal_Date

Fec_Date

Proc_no

Cal By

Version

Tenp

Humidity

Mvolt

MFreq

Cal_Int

Cert_Complete

Quality

Edit Cal_Ref

‘-:lrj Tip : The data displayed can be modified. Click Save to save the changes or click Cancel to abort without saving.

813

(%

Delete Certificate| | Save Changes
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All the details of an instrument can be changed in this menu, so care should be taken that
important data is not lost, this function can be set to Administrator Access only. The list of
enterable data is long; this list contains the information for every part of the instruments
procession through Booking In, Calibration and its Despatch details.

Certificate Number

If an instrument has been subcontracted out to an external company, then upon its return,
the certificate will need to be linked to the instruments details, go into the Advanced Edit of
that instrument, highlight ‘Cert_No’ by clicking it, and then type the certificate number into
the text box below, once the information has been entered click “Save Changes” and then
“Yes”. For a sub-contracted instrument it is advisable to also scan and link the certificate to
the instrument.

* _ Edit Calibration Information For Instrument TL756

Dezcrption Data

Cal Ref : L
Inat ID : 3
Cust_Ref :

Cal_Date

Fec_Date

Froc_no

Cal By

Version

Tenp

Humidity

MVolc

MFreqg

Cal_Int

Cert Complete

uality

Edit Cert_Mo
|2?aa

54

\_:1‘_) Tip : The data displayed can be medified. Click Save to save the changes or click Cancel to abort without saving.

Editing Signatories

Delete Certificate] | Sawve Changes

To edit the signatory of a certificate, the same method is followed as for entering a
Certificate Number, search and open the Job Sheet of the required instrument, open The
Advanced Edit menu, and scroll down, highlight the line data that needs to be entered, and
type the information into the text box.
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* _Edit Calibration Information For Instrument TL756

Dezcription [rata

Lab Zdd 4 : ~
Leb 2dd 5 :

Signatory 1 : J, Bailey

Jignatory 2 :
Signatory 3
Signatory_4
Signatory_5
Sva_No

Marg Fass
Inst Desc 1
Jerial 1
Cert No 1
Cal _Date_l
Cal_Pericd 1
Inat_Desac_2

Serial 2

(%

Edit Signatory_1
|J . Bailey

‘-:lrj Tip : The data displayed can be modified. Click Save to save the changes or click Cancel to abort without saving.

Editing Traceable Instruments

Delete Certificate| | Save Changes

The same process can also be applied for editing the traceable instruments that were used
during the calibration process. As the image below shows, each traceable instrument has
its name, serial number, certificate number, the date that instrument was calibrated, and
the calibration period.
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* _Edit Calibration Information For Instrument

Dezcription Data

Signatory_3
Jignatory_4
Jignatory_5

[

Jya_No 2

Marg Paas : 20

Inat Deac 1 3010 Precision Multi-Product Calibrator 0
Serial_1 :

Cert_No_1

Cal_Date_ 1 v 03/12/08

Cal Period 1 32

Inat_Desc_2 : 34582 Multimeter

Serial 2

Cert_MNo_ 2

Cal Date_ 2 20/11/08

Cal_Pericd_2 52

Inat_Desc_3 bl

Edit Inst_Desc_1
|3EI1 0 Precizion Mulki-Product Calibrator

\_:1‘_) Tip : The data displayed can be modified. Click Save to save the changes or click Cancel to abort without saving.

Delete Certificate] | Sawve Changes

Note: Once Save is clicked, any changed data will be saved and could affect certificates, reports, and
can change information such as despatch addresses, therefore it is wise to operate within Advanced
Edit with care.

Note: Only a user with administrator access will have the Advanced Edit function available to them on a
Virtual Job Sheet, both the engineer and the operator are unable to access this menu.

Editing Drop Down Menus/ “...”

Each drop down menu will have a button next to it with three dots “...”, once clicked this button will open up a
text file in Notepad, once the changes have been made save and close the text file. For the changes to appear
in the drop down menu, the screen that is being worked from must be reset.

Note: The program will not need to be reset, only the current screen or menu will need to be closed and
reopened.
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Contact Us

Telephone

+44 (0) 1580 890700

Fax

+44 (0) 1580 890711

Email

sales@transmille.com

All of these details and more can be found at our website www.transmille.com
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